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COPYRIGHT NOTICE 
Copyright © 2010 by TOHO Technology. All rights reserved worldwide. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval system or translated into any human or computer 
language, in any form or by any means, electronic, mechanical, magnetic, chemical, manual, or otherwise, without 
the express written permission of TOHO Technology.

WARRANTY 
Except as otherwise indicated, TOHO Technology warrants to the Buyer that the items sold by it hereunder are 
free from defects in material and workmanship and meet applicable specifications. In discharge of this warranty, 
Tencor Instruments agrees either to repair or replace as it may elect, any part or parts which under proper and 
normal use proves defective in material or workmanship within twelve months after delivery to Buyer, except for 
optional printers. If it is recognized that some components and accessories fail to give reasonable service for a 
reasonable period of time, as determined solely by TOHO Technology, TOHO Technology will at its election 
replace or repair them. TOHO Technology may at any time discharge its warranty as to any item by refunding the 
purchase price and taking back the item.
Unless Buyer shall inspect all items and within thirty days of delivery notify TOHO Technology of any apparent 
defects discovered and shall return the apparently defective item, transportation charges prepaid, to the TOHO 
Technology factory or service office if so directed, TOHO Technology shall have no liability hereunder.
The foregoing warranty and remedy are exclusive and TOHO Technology shall have no other liability under any 
other warranty express or implied either in fact or by operation of law, statutory or otherwise. TOHO Technology 
shall have no liability for special or consequential damages of any kind and from any cause arising out of the 
installation or use of any item.

TRADEMARKS 
TOHO Technology® is a registered trademark of TOHO Technology

PATENTS
This instrument is protected under the following patents: 5134303 and 524889.

AN IMPORTANT MESSAGE
Thank you for selecting the TOHO Technology FLX-2320-S and welcome to our growing world-
wide family. Please read this manual carefully to familiarize yourself with the FLX-2320-S. 
The TOHO Technology applications staff or the TOHO Technology Service Department will be 
happy to assist you with any questions you have about your instrument.
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OPERATING SAFETY

LASER 
The TOHO Technology FLX-2320 contains two solid-state lasers: a Class IIIa laser with 4 
milliwatts (mW) power and 670 nanometers (nm) wavelength and a Class IIIb laser with 4 
mW power and 780 nm wavelength. The lasers comply with Title 21 of the United States 
Code of Federal Regulations (CFR), Chapter 1, Subchapter J, Sections 1040.10 and 1040.11, 
as applicable.

Pursuant to the Regulations for the Administration and Enforcement of the Radiation 
Control for Health and Safety Act of 1968 (pertinent to laser products), a document 
describing this product has been filed with the Consumer Industrial Products Branch (HFZ-
312) of the Division of Radiological Products of the National Center for Devices and 
Radiological Health (CDRH). 

The CDRH requires that all laser products be maintained to keep them in compliance with 
CDRH’s regulations. To maintain compliance with CDRH regulations, verify the operation 
of the Beam Attenuator (turns the laser beam off when the instrument door is open) annually 
or whenever the product has been subjected to adverse environmental conditions (mechan-
ical shock, spilled solvents, and fire).

WARNING: Do not defeat the electrical or mechanical interlocks. When the 
interlocks are defeated, laser beams of Class IIIb medium power 
could be present. These beams are a safety hazard. Also avoid 
direct exposure to the laser beam.

When operating the FLX-2320-S, comply with safety precautions described in this section; 
you can consult OSHA, ACGIH, and ANSI standards for additional guidance.

During instrument installation, instrument maintenance, or laser service, avoid unnecessary 
exposure to laser or collateral radiation exceeding the acceptable emission limits listed in 
the section titled “Performance Standards for Laser Products,” in the CFR, Section 
1040.10(d).

Sample Certification and Identification and Interlock labels are displayed on the following 
page.
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Sample identification label:

Sample certification labels: 

Sample interlock labels:
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VOLTAGE
The system contains components requiring electrical voltages of 115 V or 230 V.

Interlock 
Warning 
Label

Certification and 
Identification Labels
(on the back panel)

Emission 
Indicator

Laser 
Keyswitch

Door to Measurement 
Chamber
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HIGH TEMPERATURES
The hot plate and measurement platform are very hot (up to 500o C) when the heater is 
operating.
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1 INTRODUCTION

1.1 ABOUT THIS MANUAL
This manual is divided into the following chapters:

• Chapter 1, “Introduction,” provides information on the manual organization, con-
ventions, and terminology.

• Chapter 2, “Instrument Overview and Installation,” provides information on instru-
ment features, installing the instrument, and installing and upgrading software.

• Chapter 3, “Using WINFLX,” provides information on using User Files, Process 
Programs, the Materials Database, Verifying Calibration, installing and Upgrading 
Software.

• Chapter 4, “Performing Measurements,” covers the measurement modes of first 
stress, single stress, stress-time, stress-temperature and 3-D Scans.

• Chapter 5, “Managing Data Files,” covers the Data Editor window, and the various 
functions that can be done within the window.

• Chapter 6, “Creating and Displaying Graphs,” covers creating and displaying 3-D 
graphs, trend plots and graphs.

• Chapter 7, “Data Analysis,” covers the various calculations, record comparisons, 
and analysis of data files.

• Chapter 8, “Maintenance,” provides information on basic instrument maintenance, 
troubleshooting, calibration, and diagnostics.

• Chapter 9, “Theory of Operation,” provides a brief overview of the theory of 
operation of the instrument.

• Appendixes describe the instrument specifications, and constants and conversions 
used in calculations, and the cooling stage option.

• A glossary and an index are also provided at the end of this manual.
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1.2 HOW TO USE THIS MANUAL
To get the most out of this manual, you should work sequentially from Chapter 3, “Using 
WINFLX” through Chapter 7, “Data Analysis.” Chapter 8, “Maintenance,” should be used 
by the key person responsible for maintaining the instrument.

CAUTION: We also strongly recommend that you read the section on Operating 
Safety on page vii before operating the instrument.

1.2.1 TERMINOLOGY 
Before continuing, you need to familiarize yourself with several terms used throughout 
this publication.

User

The operator of the instrument and the software.

Arrow Keys
The four arrow keys on the computer keyboard. Each arrow key points in a specific 
direction. To move the selection bar in menus, press [↓] to move the bar downward and 
[↑] to move the bar upward. To activate the menu item, press ALT, and then use the arrow 
keys to select any menu. Press [→] to select menus left to right and [←] to select menus 
right to left.

Command
The action associated with one of the options appearing on a menu and activities performed 
when keys are pressed on the keyboard.

Cursor
Small blinking dash appearing in the alphanumeric fields. The cursor serves as a pointer 
marking the location where characters appear when you type.

Directory
Computer files are stored on the computer’s hard disk in directories. The directory name 
identifies the location where the files are stored. 

Field
Reserved area provided on many windows for typing data, displaying data, or selecting 
options associated with the field. Three types of fields can appear on windows—data entry 
fields, option fields, and display-only fields. Data entry fields are reserved for typing 
numeric values or alphanumeric data. Option fields have predefined values. Display-only 
fields are used by the instrument to display the current status of hardware.
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Highlight
A field that has a different background from the other fields indicating that the highlighted 
field is to be replaced.

Menu
A list of actions. For example, the File menu contains file related actions. Inactive items 
in the menus are dimmed. 

Process Program
A Process Program is a set of parameters specifying information such as the number of 
scan points, elastic modulus, substrate thickness, and wafer diameter for the measurement.

Scan
Action performed when the TOHO Technology FLX-2320-S optical system and measure-
ment stage are used to inspect wafers.
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2 INSTRUMENT OVERVIEW AND INSTALLATION

This chapter provides information on the following:

• Instrument features

• Operating environment and site requirements

• Procedures for installing the instrument and software

• Procedures for installing upgrades to the software

2.1 INSTRUMENT OVERVIEW

2.1.1 FEATURES
The FLX-2320-S is a thin-film stress measurement instrument. It accurately measures the 
changes in the radius of curvature of the substrate caused by the deposition of a stressed 
thin film on the substrate. Some of the features include

• Laser scanning technology to accurately measure stress on all reflecting films. Stress 
can also be measured as a function of time or temperature (standard temperature 
range from room temperature to 500o C; optional temperature range -65o C to 500o

C). The software displays regular and time-dependent stress measurements in graph 
form automatically.

• An optional inert atmosphere capability that allows measurements to be made in a 
controlled atmosphere of nitrogen or argon.

• Only one moving element in the optical components ensures low vibration and high 
accuracy.

• Ability to customize parameters such as number of scan points, elastic modulus, 
substrate thickness, and wafer diameter in the Process Programs. Heating and 
cooling cycles can be specified in recipes for stress-temperature measurements.

• Ability to edit data records, plot graphs, and trend charts. Stress can be calculated 
for a saved data file by changing the elastic modulus, wafer thickness, or film 
thickness.

• Comprehensive data analysis capabilities that include calculating the biaxial mod-
ulus of elasticity and linear expansion coefficient, displaying thermal stress super-
imposed on stress-temperature measurement data, stress uniformity, file subtraction, 
trend plotting for statistical process control (SPC), calculating the water diffusion 
coefficient in dielectric films, and displaying a 3-D map of the deflection over the 
wafer.



FLX-2320-S Chapter 2 - Instrument Overview & Installation 6
7/10 TOHO Technology 6

2.1.2 SYSTEM COMPONENTS 
The FLX-2320-S system consists of a desktop computer, keyboard, monitor, mouse and 
measurement unit. Figure 2-1 shows the measurement unit with its door closed. 

Source Power LED, Temperature Display, Heater Switch, Fan Switch, Laser Keyswitch, 
and the Main On/Off Switch are located along the top front of the cabinet (Figure 2.2)

Heater Switch Fan Switch
Main Power 

Laser Keyswitch

Temperature Display

LED IndicatorsSource LED

Figure 2.2 Top Front of Cabinet
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2.2 OPERATING ENVIRONMENT
The instrument must be installed on a reasonably flat, rigid foundation. 

Facility Specification   

Temperature 18–22° C (64–72° F)

Air Quality The FLX 2320-S is a clean tool. It is designed to operate 
in a class 100 Clean Room. 

Gas Connections 
(Standard  
instrument)

Inert gas flow rate: 2–10 CFH(3L/min=6.4CFH);  
Cooling gas (typically CDA or N2) flow rate: Up to 500 
CFH (236L/min=500CFH); pressure not to exceed 40 
PSI. (.3 MPa= 43.5psi).

System Power 15 amp. at 230 V, 50/60 Hz

      

CAUTION: Avoid operating the FLX-2320-S near strong electrical and magnetic 
fields, emitters of radio frequency interference, sources of mechan-
ical vibration, or contaminating or corrosive vapors.

2.3 SHIPPING CONTENTS
The following items are shipped with the unit:

• One FLX-2320-S Instrument

• One Desktop Computer, one Monitor, one Keyboard, one Mouse

• Two FLX-2320-S User Manuals

• One FLX-2320-S software diskette

• Two Laser activation Keys

• User Manual CD Rom

Laser Activation Keys
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• One Wafer Hot Plate Cover

Solenoid Valve AssemblyWafer Hot Plate Cover

• One Solenoid Valve Assembly

• One 8.25" Quartz Plate (Very Fragile!)

• One copy of Windows Software

• One Disk with System calibration and configuration Back-Up files

The following items are optionally available:

• Positioning Rings, USA- 3", 4",5",6" Japan- 3",6"

• Gas Panel

• Printer

• Wafer Stress pair; 150mm or 200mm

• Mirror set; Radius 20meter & Flat mirror

• Mirror Positioning Ring

• 3-D Mapping Software

• Lo-Temp option: enables instrument to reach -65 oC
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2.4 INSTRUMENT INSTALLATION

2.4.1 SHIPPING DAMAGE 

NOTE: The carrier is responsible for damage incurred during shipping and 
should be contacted immediately if the shipping containers appear 
damaged (see below). Be sure to retain all damaged containers and 
documentation for inspection by the carrier.

Each shipping container has a Shockwatch monitor and a Tiltwatch monitor on the outside 
of the container. Sample labels are displayed here.

SHOCKWATCH MONITOR   

If the shockwatch indicator in the middle of the monitor is red, the crate was not properly 
handled. Note that normal movements and acute angles during aircraft take-off and landing 
do not activate the indicator. If the indicator is red, make a notation on the bill of lading 
and service report and check the instrument for damage. If the instrument is damaged, 
notify the carrier and the service dispatcher at TOHO Technology.

Also verify that the sticker “FACTORY SEALED, TOHO Technology Inc " is still intact. 
If the seal is not in place, the instrument could have been mishandled by the carrier. If the 
seal is missing or not in place, make a note on the Service Report. Check the instrument 
for damage and notify the carrier and the service dispatcher at TOHO Technology in case 
of damage.

.
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TILTWATCH MONITOR 

Figure 2-1 Tiltwatch Monitor

If the indicator in the center of the label is red (normal state is white), then the container 
was tilted on its side or completely upended. Note that normal movements and acute angles 
during aircraft take-off and landing do not activate the indicator. If the indicator is red, 
there could be possible damage to the instrument. Make a note on the bill of lading and 
the Service Report. Check the instrument carefully for damage and notify the carrier and 
the service dispatcher at TOHO Technology in case of damage.
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2.4.2 PRE-INSTALL
The FLX 2320-S is a precision instrument. Although calibrated at the factory, upon finding 
its permanent operating place it will need to be re-calibrated by a qualified Toho technician. 
Before scheduling an installation date, the user needs to have filled out a pre-install 
checklist. Before installation, facility has to be equipped with:

• Stable Temperature between 18C & 22C (64F & 72F)

• Instrument Power: Instrument comes with a NEMA L6-30 plug (3 prong 30A) for 
USA customers. Instrument draws 15A. and runs on single phase 230V, 50/60 Hz. 

• Computer Power: requires 1A (0.36 nominal) two 115V outlets (PC & Monitor)

• Inert gas: Unless the Toho Gas Panel was purchased as an option, customer-supplied 
valves and flow meters are required for all gas connections. Inert gas connection is 
1/4" Swagelok.

• Cooling Gas: Cooling gas runs through a closed loop inside the stage. The gas never 
"sees" the wafer. Typically Compressed Dry Air is used. Some labs will use 
Nitrogen. Cooling gas should be set at 500 CFH (23.6L/min=50CFH) with a head 
pressure of 40 psi. (.3 MPa= 43.5psi)
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2.4.3 ATTACHMENT

A- PC Power Switch
B- PC Power Cord
C- 115/230 Switch
D- Keyboard Input
E- Monitor Input
F- USB Mouse Input
G- Temperature Cable
H- Motion Cable
I- I/O Cable #1
J- I/O Cable #2
K- Fuses
L- Instrument Power Cord
M- Solenoid Signal Input
N- Inert In
O- Cooling In/ Solenoid Assembly
P- Cooling Out
Q- Inert Out

Only on Lo-Temp option:
R- Additional N2, for N2 blanket

A
B

C

D
EF

G

H

I
J

K

L
H

J

I

M N O P Q R
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1. Attach Nema L6-30 plug to facility receptacle. Verify "Source Power" is lit on the 
front of the tool.

2. Attach PC & Monitor Power Cords to standard 115V outlets.

3. Attach Keyboard to keyboard input.

4. Attach Mouse to USB port.

5. Attach Temperature Cable (Black Cable) to the back of tool and to 4th slot from 
the bottom on the back of the PC.

6. Attach Motion Cable that is hard wired to the Instrument to the 3rd slot from the 
bottom on the back of the PC.

7. Attach I/O #1 Cable to the back of the Instrument and to the 2nd slot from the bottom 
on the back of the PC. This is an off-white cable that snaps in place at both ends.

8. Attach I/O #2 Cable that’s hard wired to the tool, to the bottom slot of the PC.

9. Attach Solenoid Assembly to the "Cooling In" port on the rear of the tool. The 
Swagelok nut will already be on the solenoid assembly. This is a 1/4" Swagelok 
connection. A 7/16 open wrench will tighten it. Attach 2 wire connectors from the 
solenoid assembly to the "DC Input". Attach 1/4" tube to the One-Touch quick 
disconnect on the solenoid valve assembly.

10. Attach Inert gas supply to "Inert In". This is a 1/4" Swagelok connection. A 7/16 
open wrench will tighten it.

11. The "Cooling Out" and "Inert Out" ports are available to plumb into the chase. The 
Cooling will be noisy during a cool down if not exhausted elsewhere. If the inert 
gas is Nitrogen it is harmless to exhaust into the lab. If it is Argon, be sure to exhaust 
it properly.

The tool is now ready to be energized. Turn on the PC, turn on the main breaker on the front 
of the instrument. There will be a shortcut on the desktop that says "WINFLX". Double 
click to open.
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3 USING WINFLX

Once the instrument is connected, the power and facility connections are connected, and 
the software is opened, the User can begin to perform scans and analyze data. The 
instrument should be calibrated by a TOHO technician. The FLX 2320-S uses Software 
called “WINFLX”. This chapter covers:

• Logging In and creating User files

• Creating and using Process Programs

• Using the Materials Database

• Verifying the Instrument Calibration

• Installing & Upgrading Software

3.1 Creating a User File
1. After clicking on the WINFLX icon, you will 

see another “Stress Cat” while the program 
loads. Do not fear the cat!

2. A “Login User Name” window ap-
pears. Select from the list and press 
“OK”, or to create a New User, click 
“New...”

3. A “New User” window will appear. 
Enter the name of the new user in the 
field provided. Then click “OK”.
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4. The new User Name creates a new folder. This folder can be found at: 

C:\WINFLX\NewUser

This folder will contain all of the Process Programs, Recipes, and data Scans for 
this user. 
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3.2 Process Programs
1. In order to do any scan, you need to set up the correct Process Program. Go to the 

Edit tab on the top of the main screen. Select “Process Programs.”

2. The Process Program sets up parameters for different wafers. An incorrect process 
program may give erroneous results.

Maximum Scan Points-
The default is 50. A single 
scan may have up to 1250 
scan points. However only 
scans with 50 scan points 
may be saved.

Low Intensity Alarm- The 
default is 0.2 (this is amount of 
light reaching the detector in 
terms of voltage.) Typically a 
bare silicon wafer will reflect 
between 2.0 and 3.0 volts. 
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Elastic Modulus- This field is controlled by a drop down menu. The default is for 
silicon. Use the drop down menu to select a different material. If it is not in the menu, 
then go to the Materials Data Base and enter the new material and its properties.

Substrate Thickness- This is in terms of micrometer (µm). Example below shows an 
8 inch wafer that is 725µm thick. Substrate thickness can be adjusted during the “First 
Scan” or after the measurements in the Editor menu. It’s best to be as accurate as 
possible.

Wafer Diameter- This is in terms of millimeters. 8 inch = 200mm, 6 inch = 150mm, 5 
inch = 125mm, 4 inch = 100mm

Hole Diameter- This is also in terms of millimeters. This is used for measuring stress 
on disk with a hole in the center. This feature may also be used to skip a portion of the 
center of the wafer when measuring.

Save Scan- When this checkbox is checked, the software will save the data from the 
scan for future use or review. Save Scan may only be used when there are 50 scan 
points. 
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AutoScan - When this checkbox is checked, the software automatically disregards the 
outer 10%. For example: a 200mm wafer with Auto Scan checked will take points from 
20mm to 180mm. The outer 10% typically has noise and is not as important as the inner 
90%. With the box unchecked you may enter a beginning and end point in terms of mm 
(Left to Right from left edge of wafer). Example below shows the box unchecked and 
a scanning section from 10 mm to 190 mm selected (disregarding the outer 5%).

Units-The default is MPa. It is also possible to select Dyne/cm2. 

(1MPa=1 x 107 Dyne/cm2)

Wafer- choices are Flat and Notch. Most wafers have a flat. Typically 8 inch wafers 
have a notch.

Laser Selection- “670nm” is the Red laser (vertical laser). If you select “670nm” the 
tool will deliberately use the 670nm laser when doing scans with this Process Program. 
“780nm” is the infrared, yellow (horizontal laser). When “780nm” is selected, the tool 
uses only the 780nm for scans. “Both” selects both lasers together for the scans. Most 
often it is best to select “Automatic”. When on “Automatic”, the tool takes one sample 
point with each laser and then automatically chooses the laser with the best intensity. 
Different materials reflect the two wavelengths differently.

Automatic Stress Calculation- This box can only be checked if there are 50 scan 
points in the Process Program. This feature will calculate stress. If this box is not 
checked, the tool will only do radius and deflection calculations.
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Load- The Load button allows you to recall previously created Process Programs. 
Process Programs have “.PRC” as extensions. Process Programs are saved in the 
“PROCESS” folder by default. Any user may access the “PROCESS” folder.

Save- The Save button saves the Process Program in the “P ” folder.ROCESS

Close- The Close button closes this window. The most recent Process Program brought 
up will be the Process Program used when going to do a First Scan.

3. Now that your Process Program is set to the desired parameters, close the Process 
Program window. Select the “Measure” tab on the main screen. Select “First (no film)”
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Comment: The comment field is for the user to easily identify scans when looking in 
the editor menu. There will be many scans, and the comment has no effect on the scans.

Export Deflection Data: If this box is checked the position on the wafer and the 
position on the detector will be exported to a file for every one of the 50 points. The file 
goes to C:\ WINFLX\File Export. It is stored as a “.TXT” file.

 File: you can either create a new File (folder) 
for the data from this scan to be stored in, or 
you can recall an existing File by pressing the 
“Files” button and selecting a file from the se-
lections in the window that pops up. It will be 
important to know the name of the file that 
contains the ID for the wafer you’re calculating 
the stress of.

ID: This is the Identity of the wafer. The ID is 
how the instrument correlates the First Scan 
(pre-deposition) to subsequent Scans (post-
deposition.). Be sure every wafer is given a 
unique ID.

Orientation: The default is 0. This field en-
ables the user to identify the orientation of the 
diameter that is being measured. That way the 
first scan and the single, time, or temperature 
scans will be over the same diameter of the wa-
fer. This is very important for 3-D mapping.
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The image to the right is an example of the 
TXT file created when the “Export Deflec-
tion Data” box is checked. The first col-
umn is the position on the wafer from left 
to right. Notice the first point at approxi-
mately 20mm (indicative of Auto-Scan be-
ing selected).

The second column is the deflection. The 
farthest point from 0 is the “bow”. In the 
example “-28.16” is the bow. This is in 
terms of micrometers (µm)

The beginning and end point of the scan 
will always be 0’s.

Substrate Thickness: This field will have 
a default thickness that was entered in the 
Process Program. The field is adjustable. 
Rather than make several Process Pro-
grams, you may use the same Process Pro-
gram for several wafers that share diameter 
and material attributes, but slightly differ in 
thickness. 

The bottom box of the window reminds you of 
the name of the Process Program, The Elastic 
Modulus selected, The Wafer Diameter, and 
whether Autoscan is ON or OFF.
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Measure: The measure button will start the scan. The 
entire scan will take about 20 seconds. You should hear 
the linear motor moving the Laser assembly. Measuring 
requires an ID, a file to send the data to, and a substrate 
thickness.

At the beginning of the scan, a window will pop-up in the upper right hand corner telling which laser 
was selected. At the end of the scan 2 windows will pop-up. There will be a graph of the intensity at 
each point and a graph of Radius, Bow, and Deflection. These windows will only close by pressing 
“Cancel” on the “First Measurement” window. To recall these graphs later, you must “save graphs”.

Cancel: Pressing the “Cancel” button will close all of the pop-up windows and exit you from the 
“first measurement” mode. Although the graphs will not be saved unless you deliberately save them, 
the data from the scan is automatically stored. Scan information can be reviewed in the editor menu.
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3.3 Materials Database
New materials can be added to the Materials Database. TOHO provides several 
choices for the substrate material in the Process Program drop down menu. If the 
elastic modulus properties of a material is known, it can easily be added to the 
Materials Database.

1. Select “Materials data base” from the “Edit” tab.

2. The materials are sorted alphabetically by name.
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3. To edit an existing coefficient: 

• Use TAB to move the cursor to the coefficient line and click once to highlight 
the first field for editing.

• After editing each field, press TAB to move to the next field. To erase the 
entry in a field, use the backspace key. To exit a field without editing it, 
press TAB. When you press TAB in the last field of the line, the cursor moves 
to the next line.

2. To add a new coefficient on a blank line: 

• Enter the name of the material in the first field, the biaxial modulus (in Pa) 
in the second field, and the linear expansion coefficients in the next three 
columns. After entering a value in a field, press TAB to move to the next 
field. To erase the entry in a field, use the backspace key. When you TAB
in the last field of the line, the cursor moves to the next line.
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4. Once the properties of the material have been entered, Click the “Save” button to 
save the material in the Materials Database.

5. Clicking the “Sort materials” button will alphabetize the materials.
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6. Deleting a Material from the Materials Database,

• Select a cell. Then hold the “shift” key and select the right-most cell of the row. The 
row should highlight. 

• Then press the “Delete” button.

7. If changes have been made to the Materials Database, (deleting materials, adding 
materials, changing properties, etc....) then a prompt window will appear upon 
exiting. 

8. Click “Yes” to save the changes to the Materials Database.
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3.4 Verifying the Instrument is in Calibration

3.4.1 Calibrated Mirror Verification: 
If the user has purchased the optional mirror set, they can set the appropriate Process 

Programs and measure the mirrors. The mirror set should come with a Certification. 
The 20 meter (approximately 20 meters, spec sheet should specify exact radius - e.g. 
19.96m) should measure within 5% of the nominal value.

1. Set up a Process Program for the mirrors; they are typically 100mm in diameter and 
12,700 mm thick (substrate thickness). The picture below to the right is the bottom 
of a radius 20 meter mirror. The actual radius is 19.960m. The actual substrate 
thickness is 12,850mm. The serial number is also on the Certification Record. It’s 
recommended practice to write this information on the bottom of the mirrors.

2. Place the Mirror Positioning Ring on the stage. The Mirror Positioning Ring has a 
square cut out. There is a hash mark that should face up. The hash mark will be to 
the left. This will line up with a hash mark on the side of the mirrors. This is to 
ensure that the same diameter is always measured. Locate the mirror in the corner 
of the square that is far and to the left of the user.

3.

4.

5.

6.

7.

8.

9.

10.

11.
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3.4.2 Calibrated Wafer Set
If the user has purchased the optional calibrated wafer set, they can set the appropriate 
Process Programs and measure the calibrated Stress. The mock Stress should read 
within 5% of the Certified Stress

1. Set the Process Program up for your Wafer set. Be sure to use the thickness and 
diameter from the Certification.

2. Use Wafer A for the first scan. Perform the scan and then close (cancel) the First 
Scan Window.

3. Exchange Wafer A for Wafer B. Select “Single Scan” from the “Measure” tab. 
Select the ID from the drop down menu that is the same ID that was used for the 
first scan for wafer A.

Enter the film thickness specified on 
the Certification. Typically it is 
10,000 angstroms. (10,000 A)

The resulting Stress should be within 
5% of the Certified Stress if the tool is 
in calibration.

Take note that the flat or notch orient-
ed to the right is considered 0 degrees. 
(Like the origin in Geometry). The flat 
away from the user is considered 90 
degrees (rotating counter clock wise).

Wafer is at 0 degrees Wafer is at 90 degrees
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3.4.3 Utilities Menu Checking Position & Intensity:
1. Place a bare silicon wafer on the stage.

2. Click on the “Utilities” Menu from the main screen.

3. Select “Laser Intensity/ Move Laser”

4. You can select 670nm, 780nm, or both lasers. 

• The intensity for the 670nm laser (red or vertical) is nominally 3.08. The spec is 
from 2.58 to 3.58.

• The intensity for the 780nm laser (yellow or horizontal) is nominally 2.75. The 
spec is from 2.25 to 3.25

• The nominal intensity for both lasers is 3.08 + 2.75 = 5.83
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5. Position: Position refers to the position on the detector. The nominal position 
(DIFF) is 0.000. The tool is in spec from -0.100 to + 0.100.

6. Set Laser at Center: When this Utility Menu is opened, the tool will automatically 
move the laser to the center of travel across the wafer. This button is used as a reset 
in case you’ve moved the laser.

7. Move to desired distance: This field lets you enter a relative distance in terms of 
millimeters for the laser to move. Negative numbers will move to the left; positive 
to the right. This is a RELATIVE movement. It is possible to command the laser 
beyond its stroke and jam the motor. Be very careful to check the laser’s position 
before you give it a command! There is a graphic that will indicate where the 
software believes the laser is pointing.

8. PC Ports Diagnostics & Laser Status:

• Select the “PC Ports Diagnostics & Laser Status” selection from the Utilities 
Menu. This will show the DIFF (position on the detector) and the Intensity 
for both lasers simultaneously.

• RS232: Refers to the I/O cable.

• Temperature Controller: Refers to the 
Eurotherm on the front of the tool.

• 0 Serial Ports installed: Tells you the 
communications with the PC is OK.

• Motor functioning: Tells you the feedback 
from the motor encoder is OK.

• Table Leveling: Refers to the stage. If this 
Utility Menu says “CW” (clockwise) or 
“CCW” (counter-clockwise), it is referring to 
t he  ad ju s t ab l e  t humb  sc r ew.  Toho  
recommends NOT adjusting the thumb screw. 
The leveling was done at the factory and is 
locked in place. A “CW” or “CCW” reading 
in this Utility Menu usually means the wafer 
isn’t sitting flat on the 3 ball bearings.
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3.4.4 INSTALLING AND UPGRADING SOFTWARE
Toho Technology installs the FLX-2320-S software before the instrument is shipped. 
However, if a serious software or hardware problem occurs, you might need to reinstall 
the software. You will also need to install upgrades to the software. Use the instructions 
in this section to reinstall software. For upgrades, follow the instructions provided with 
the upgrade diskettes.

To reinstall the software: 

1. Insert the FLX-2320-S software CD or diskette into the disk drive.

2. Exit the FLX software.

3. From the Program Manager in windows, choose Run from the File menu.

4. When setup is completed, reboot the system.

5. Type a:setup and press OK.

6. Start the FLX software. 
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4 PERFORMING MEASUREMENTS

4.1 STRESS MEASUREMENTS
Stress measurements involve setting up a Process Program, taking a measurement of the 
undeposited wafer, and finally a measurement of the deposited wafer. The Toho FLX-
2320 instrument also provides the option of taking stress measurements at specified 
intervals over a specified length of time and taking stress measurements as a function of 
temperature. All these measurement options are described in the following sections.

Process Program 

Choose or create the correct Process Program for the wafer before you perform the 
first measurement (no film).

4.1.1 First Measurement (No Film)
1. Place wafer in the instrument. Be sure the correct Process Program is chosen. Be 

sure the instrument power is on, and the lasers are switched on.

2. Go to measurement tab. Select 
“First (no film)”

3. Verify the Process Program is the 
intended Process Program. (e.g. 
suran.PRC)

4. Verify the substrate thickness is 
correct, the field allows you to 
adjust if more accurate thickness 
is known. (e.g. 725 µm)

5. Be sure to give this wafer a 
unique “ID” (identity). The ID is 
what will corollate the wafer’s 
pre-deposition scan to its post 
deposition scan.

6. When all parameters are set 
properly, click the “Measure” 
button.
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7. Three windows will pop-up. The first will be the laser 
selection window. This will be a small window that 
appears in the top right corner.

8. The next two graphs will pop-up at the end of the scan. They will be the Light 
Intensity graph and the Deflection graph.

The Light Intensity graph is a 
function of the amount of light 
in terms of voltage (light inten-
sity) over position on the wafer 
in terms of millimeters.

Each point represents a scan 
point. (e.g. at 100mm the light 
intensity was 4.90 volts)

These windows will not close 
with the conventional win-
dows X box in the upper right 
hand corner. You need to press 
“Cancel” on the “First Mea-
surement” window to close 
these windows.

The deflection graph is a func-
tion of bow (in microns) over 
position on the wafer in milli-
meters.

The tool will always consider 
the first point of the scan and 
the last point of the scan to be 
0. Points bowing below that 
line will be considered to have 
a negative bow, above the line 
will have a positive bow.

NOTE: The default font is 
short and fat, be sure not to 
confuse an equal sign “=” for a 
negative sign “-”. 

(e.g. Bow = -28.16mm)
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9. Saving Graphs -If you want to save these graphs that pop-up, do not press “Cancel” 
on the First Measurement window until the graphs have been saved. To save the 
graphs, go to the “File” tab and select “Save As”. These files have to be saved 
individually. The most forefront window (boldest border) will be the graph saved. 
Both graphs can be saved, just not at the same time. Graphs are saved as “.GRP” 
files. These can be recalled and analyzed at a later time.

10. Note that if you measure the sample again using the same ID, a second record is 
created and saved without overwriting the first record. The most recent record is 
used as the valid record when measuring stress after deposition.

4.1.2 Single Scan
Once the deposition has been made on the wafer, place it back on the stage inside 
the tool. This measurement will generate a stress measurement.

1. Select “Single” from the Measure tab on the main screen.
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2. The “Single Stress” window will appear.

File: The file field will tell you 
where the data is going to be 
stored. It also tells you from 
which file it will seek wafer 
ID’s. You can write in the file 
name in the field or press the 
“files” button to navigate and 
select a file.

ID: In the Single Scan Mode, 
ID’s are available in the drop-
down menu. Be sure to select 
the correct ID for the wafer 
you’re measuring Stress on.

Orientation: This field may 
only be changed with the use of 
the drop -down menu. The de-
fault is 0. This is primarily used 
for 3-D scans.

Comment: Just like before, this field is for the user’s benefit when navigating several scans in the 
Editor menu. This field cannot affect the measurement.

Film Thickness: This is in terms of angstroms. There will be an error message if this field is left at 0. 

Export Deflection Data: When this checkbox is checked, the deflection data for each point is exported 
to a file.

3. Press the “Measure” button. The instrument will perform a scan.

4. Next, the following windows will appear: Laser Selection, Intensity Graph, and 
Deflection Graph. The Deflection Graph will include the Stress calculation.
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5. The Stress reading will appear underneath the Radius and Bow readings above the 
graph. (e.g. -1.1129 MPa). The instrument will also indicate whether the Stress is 
Tensile or Compressive.

6. To recall this graph later, it must be saved, before cancelling out of these 
windows.(See 4.1.1 Item #9)

4.1.3 Time Measurement
Time measurements are several scans over an amount of time up to 99 hours and 59 
minutes, typically with intervals of 30 seconds. The stress-time measurement reveals 
kinetics such as water absorption in oxides, densification, phase transformations, and stress 
relaxation. Note that the total number of records in a data file is limited to 1000. Therefore 
when doing a 20 hour Time Measurement the minimum interval is 1 minute and 12 seconds 
(20hrs = 1200minutes= 72000 seconds/1000 = 72 seconds = 1min 12 seconds) This may 
also be used to determine the repeatability of the instrument on a known and stable stress.

1. Go to the “Measure” tab on the main screen. Select “Time”.
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Stress Time measurements require all of the same 
data inputs as Single Measurements. The only 
additional information you must provide is the 
time interval in between scans. 

File: Verify the File name that the scans will go 
to is the desired file for all of the several scans.

ID: Be sure this is the intended Identity of the 
wafer. The drop down menu will allow choosing 
from all of the wafer IDs in the selected file.

Orientation: The default will be zero. The drop down menu will give the choices of all the 
orientations of this particular ID within this particular File. Verify the orientation is the angle 
to be measured (especially if it was an angle different from the default of Zero).

Comment: This has no effect on the scan. It is for the user’s convenience.

Film Thickness: Must be entered, otherwise an error will pop-up “Cannot have a Thickness 
of Zero”. This is in terms of Angstroms.

Interval: This is the time in between the start of each scan. The quickest interval the instrument 
can perform is 30 seconds. You may have intervals of up to 99 minutes.

Total Time: This can be up to 99 hours and 59 minutes. Any total time of 8 hours and 20 
minutes or less may have intervals of 30 seconds. Any total time that is longer than that may 
only have intervals that will give a maximum total of 1000 scans.

Cancel Active Measurement: Time measurements might be very long. It is always possible 
to stop the instrument from completing a test. If the “Cancel Active Measurement” button is 
pressed, the instrument will complete the current scan (it may seem as though it is performing 
one last scan). It will then stop. All of the completed scans will still be saved automatically. 
They can be recalled in the editor menu.
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After the first scan of a time measurement, a pop-up window will appear and begin a plotting 
function. Each scan’s stress will be plotted over time. Remember, the graphs will always 
“scale”, so even though the arc of the graph is dramatic, the actual values may be virtually the 
same. In the example below, notice the range of stress is very small and virtually the same.

Like all the pop-up graphs, this graph must be saved in order to be recalled again. The X-Box 
in the coorner of the graph window will NOT close the window. The Minimize and Maximize 
buttons will work. To close the graph window press the “Cancel” button. Each scan’s data, 
however, is automatically saved in the specified file.

4.1.4 Temperature Measurement
Use the Stress-Temperature Measurement mode to measure stress as a function of 
temperature on a wafer after deposition. The instrument uses temperature cycling to reveal 
stress changes. Temperature cycling causes stress changes due to thermal expansion, 
mismatch, volume changes, and plastic deformations.

N : There are 2 methods of compensation for the refraction of the quartz plate.OTE

1st- Performing the first measurement (no film) with the quartz plate. This 
is the simplest method.

2nd- Subtracting the offset. Perform a “Single Scan” when the wafer stage 
is at a similar temperature to its First Scan. Then subtract this measured stress 
as an offset from the subsequent Temperature measurements.
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Procedure for Temperature Measurements
1. Install the wafer locator ring on the hot plate measurement platform and place the 

wafer, face up, in the ring. 

2. Place the quartz plate above the wafer on the inside ledge of the stage.
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3. Place the Heat Shield on top of the stage. The cut-outs go to the back for the 
plumbing. The slot will go across the wafer from left to right. This is where the 
laser shines through to the wafer. The four thumb-screws are for location. Just get 
them started. There is no need for any significant torque.

WARNING: There is no interlock for the door. It is possible to open the door when 
the Stage is very hot. Please use caution when opening the door. Check the 
Eurotherm temperature. This top reading is from a thermister inside of the hot plate.

The Eurotherm readings are in Celsius. The 
top temperature is the temperature of the stage 
(e.g. 48oC). The bottom temperature is the 
current set point. (e.g. 45oC)

Do not adjust the Eurotherm via the buttons 
on the front. All of the controls needed are 
within the WinFLX software.
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4. Select “Temperature” from the Measure tab.

All the fields displayed in the Stress-Temperature dialog box can be edited;
entering information in the Comment field is optional.

5. Enter the filename in the File field (the software assigns the extension.DAT 
automatically) to save the data points. To save the data into a previously existing 
file, click on the Data files button, a file selection dialog box displays. Choose the 
desired filename from the list.

ID: This drop down menu will give the choice of any ID of a wafer that is within this selected 
file.

Orientation: The default will be zero. The drop down menu will give the choices of all the 
orientations of this particular ID within this particular File. Verify the orientation is the angle 
to be measured (especially if it was an angle different from the default of Zero).

Comment: This has no effect on the scan. It is for the user’s convenience.
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Film Thickness: Must be entered, otherwise an error will pop-up “Cannot have a Thickness 
of Zero”. Thickness values are entered in terms of Angstroms.

Open Recipe: This button will open a file 
selection dialog box which will contain all the 
previously saved recipes within the selected 
file.

Save Recipe: This button will allow you to 
save the recipe you’ve created within the se-
lected file.

Measure: Once the desired recipe is loaded or created, press this button to begin the 
measurements.

Cancel: This button will close the “Temperature Measurement” window, and the graph created 
during the temperature measurement.

Priority Time: With Priority Time selected, the instrument will do a measurement with respect 
to time elapsed. This is according to the recipe and is regardless of whether or not the 
programmed temperature was achieved. Select this if you want to get the measurements done 
in a specific amount of time.

Priority Temp: With Priority Temp selected, the instrument will perform a scan when the 
programmed temperature is actually achieved, regardless of how much time it takes.

Cancel Active Measurement: Temperature measurements might be very long. It is always 
possible to stop the instrument from completing a test. If the “Cancel Active Measurement” 
button is pressed, the instrument will complete the current scan (it may seem as though it is 
performing one last scan). It will then stop. All of the completed scans will still be saved 
automatically. They can be recalled in the editor menu.
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Creating a Recipe

Each line of the Recipe is numbered and referred to as a “session”. The entire recipe when 
executed is referred to as an “Experiment”. The sessions are performed sequentially. The 
4th column is different depending on the Priority selected. With “Time” selected the 4th 
column will be “Reading”. With “Temp” selected it will be “Temp Steps”.

Temp oC: The desired temperature to be achieved in this session.

Time Hrs: The number of hours spent during this session. The default is 0.

Time Min: The number of minutes spent during this session. The default is 0.

Reading: This column appears only with Priority of Time selected. It designates how 
many readings will be taken during this session. The instrument can only perform 
measurements as quickly as every 30 seconds. (As in the session above, the instrument 
can perform no more than 6 scans during the 3 minute session). 

Ramp oC/Min: This is the temperature rate of rise. This will be automatically calculated 
once the Temp oC and Reading fields are entered. Entering a different value in this cell 
will adjust the Reading cell, if priority time was selected. If values are entered in both the 
Time and Ramp fields, the value in the Time field takes precedence. 

Temp Steps: This column appears only with Priority Temp selected. This is how many 
scans the instrument will perform while trying to achieve the temperature. For instance if 
the session was climbing from 20oC to 90oC, to and the Temp Steps entered was 5, then 
there would be a measurement every 14oC. (34oC,48oC,62oC,76oC,90oC).

Relay 1: This is the solenoid valve on the back of the instrument. Turn it on for cooling 
sessions.

Relay 2: This column does not have a function for model 2320-S.
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6. Once the appropriate recipe is loaded or created, press the “Measure” button. There 
will be a pop-up window titled ‘Furnace Stabilization”. It calibrates itself starting 
from 0oC up to the current room temperature. This sequence is not part of the time 
elapsed during the experiment. The clock begins once the instrument begins with 
its first scan.

7. Once the Eurotherm is stabilized the experiment will begin and the pop-up graph 
will appear. This will plot Stress as a function over temperature. It will tell you 
which file the data is going to, the wafer Identity, the current session and time 
remaining therein, as well as the time remaining in the entire Experiment.

8. Green squares denote where sessions are holding a temperature. Red triangles and 
lines denote sessions with a temperature increase. Blue circles and lines denote 
sessions with a decrease in temperature.
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9. When the final session of the Experiment has been completed the pop-up graph will 
read “Measurement Complete”. There will be an additional pop-up window that 
also reads “Measurement Complete”.

NOTE: If the last session of the 
experiment was a cooling step and 
Relay 1 was left on, the solenoid 
will stay on even though the exper-
iment is over. once the “OK” but-
ton is clicked, then the solenoid 
will close again.

10. The pop-up graph that was created can be saved. Every scan will automatically be 
saved, however this graph can only be recalled if deliberately saved.

11. Be careful not to open the door until the stage has cooled to a safe temperature.

NOTE: Since it is not safe to manipulate the heat shield nor the wafer at high temperatures, a 3-D 
measurement cannot be done in conjunction with Temperature measurements.
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4.1.5 Lo-Temp Measurement
1. Be sure the manual valve and liquid Nitrogen are attached to the instrument.

2. Set the pressure on the LN2 to 100psi (.7 Mpa)

3. Keep the manual valve closed until the cooling step of the recipe.

4. Be sure the solenoid valve is disconnected from the “cooling in” port on the back 
of the instrument.

5. Be sure the electrical connection from the solenoid valve IS connected. (there will 
be an error if that circuit is open.)

6. During any cooling step, manually open the valve that allows LN2 to flow into the 
“cooling in” port on the back of the instrument.

7. When the cooling step is over, close the manual valve.

8. For regular use, connect CDA (or Nitrogen) to the solenoid valve.

9. Connect the solenoid valve to the “cooling in” port on the rear of the instrument.
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4.2 Performing 3-D Measurements
3-D measurements are groups of First measurements on the same wafer at different 
orientations. The more scans taken the more accurately representational the graph 
will be. Deflection and Radius graphs only require one series of Scans be they First 
scans or Single Scans. Stress graphs will require 2 groups of scans; one group of 
First scans before the deposition, and one group of Single scans post deposition.

The following table shows the intervals available. The locating rings have notches 
every 15 degrees. This allows the choice of 2,3,4,6, or 12 scans. Remember scans 
are diameters. (scan at 0 degrees has all the same points as a scan at 180 degrees)

The convention universally adopted in mathematical writings as well as the Flexus 
2320-S is that 0 degrees is a horizontal line (the X- axis) and positive angles increase 
when turning Counter Clock Wise. 

A Wafer with its flat at 0 degrees is as if its flat was at 3 O’Clock, 90 degrees has 
the flat at 12 O’Clock, etc.

4.2.1 Performing a series of First Scans
1. Place the wafer in the instrument so that its flat or notch is at 0 degrees.

Orientation 
(degrees) 0 15 30 45 60 75 90 105 120 135 150 165
2 scans 0 90
3 scans 0 60 120
4 scans 0 45 90 135
6 scans 0 30 60 90 120 150
12 scans 0 15 30 45 60 75 90 105 120 135 150 165
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2. Perform a First Measurement.

3. Keep the First Measurement window open.

4. Rotate the wafer ring and wafer counterclockwise to the desired interval depending 
on how many scans are going to be used to map the wafer. The Flexus software 
will only recognize groups of scans if they begin at 0 and increase in order. 

5. Return to the First measurement window, change the Orientation field from 0 to 
the new interval (example shows 12 scans which is a scan every 15 degrees)

6. It is very important that the ID is the same for all of the scans. A warning window 
will appear informing the User that the ID is a duplicate. Typically this window 
will prompt the user to change the ID so that it is unique for each wafer. However, 
it is important that this series of scans all have the same ID, although the orientations 
will vary. Click “Yes”. 

7. Once all of the scans in a series (group) are taken it is possible to create a Radius 
or Deflection graph.
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4.2.2 Performing a Series of Single Scans.

1. After the deposition, begin the series of scans with the flat or notch of the wafer at 
0 degrees.

2. Values may not be entered into the orientation field. They must be selected from 
the drop down menu. Be sure to follow the same sequence as during the First Scans 
or other group of scans you wish to calculate stress between. 

3. It’s very important that the ID is the same for all of the scans. A warning window 
will appear informing the User that the ID is a duplicate. Typically this window 
will prompt the user to change the ID so that it is unique for each wafer. However, 
it is important that this series of scans all have the same ID, although the orientations 
will vary. Click “Yes”. 
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5 MANAGING DATA FILES

This chapter describes how to

• Copy, save, delete and rename data records

• Export, merge and print data files

• Edit data records

The procedures in this chapter assume a knowledge of instrument controls and basic 
operations such as starting and shutting down the instrument. As well, the procedures 
assume a knowledge of how to take measurements.

5.1 WORKING WITH DATA FILES
Once measurements have been taken, you can display the saved data file (extension .DAT) 
to alter, delete, or merge records, and plot graphs or trends. The procedures in this section 
describe how to display and work with data files.

There are 2 ways to open a .DAT file

1st- Select the “Edit” tab on the main screen. Select “Data Files”.

2nd- Click on the E button. (E is for Editor Menu)
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Both of these methods will take you to the same place. A window will appear with the 
most recent User’s Folder in the “Look In” field. The body of the window displays all of 
the files with .DAT extensions. 

Highlighting the file will reveal its size and when it was last modified. In the example 
below the file named “Mirror” is 36.7 KB large, and was last manipulated on 1/30/2008 
at 4:33 PM.

5.2 USING FILE MENU OPTIONS IN THE EDITOR WINDOW
Select a DAT File by clicking the “Open” button. The file will open to a spread sheet. This 
is similar to an Excel spreadsheet, but only certain fields may be manipulated. In this 
section are procedures for:

•Loading files
•Merging files
•Deleting files
•Deleting records
•Recalculating Stress by changing Film thickness or Substrate thickness.
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Record #: Each line is a record number which contains all the data stored for each scan. 
A single file may only have up to 1000 records.

ID: This is the wafer identifier. This can be edited in the Editor window.

Comment: This is where the comments become valuable. They potentially help the user 
navigate the spread sheet which may have up to 1000 records. This can be edited in Editor.

Date: The date the scan was taken in DD/MM/YYYY format.

Temp: The temperature of the stage in degrees Celsius as read by the Eurotherm at the 
time of the scan.

Radius: The calculated radius of the wafer for that scan. This is in meters. For large radius 
scientific notation will be used. (e.g. a Radius of 42,360 meters will read “4.236E4”). A 
smile is considered a positive radius. A frown is considered a negative radius.

Stress: This field is the calculated stress in terms of megapascals (MPa) or Dynes per 
centimeters squared depending upon the most recently selected unit of torque in the 
Process Program.

Film Thickness: This is the thickness of the deposition in terms of angstroms. This field 
can be edited and Stress will be calculated accordingly.

Sub. Thick: This is the Substrate Thickness in terms of microns (mm). This field can be 
edited and Stress will be calculated accordingly. 

Elast. Modulus: This field is the coefficient of the elastic expansion for the Substrate. 
(e.g. 1.805 is the modulus for silicon.) This field can be edited and Stress will be calculated 
accordingly. 
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Time: This is the time that the scan was taken in terms of hours, minutes, and seconds.

Wafer Diam.: This is the diameter of the wafer in terms of millimeters.

Position: This is the position of the laser-beam on the detector (zero is the center of the 
detector) also known as the DIFF.

Intensity: This is the amount of light reaching the detector in terms of volts. Nominally 
bare silicon will reflect approximately 3.0 volts.

Start: This is the position of the first point of the scan in terms of millimeters from left to 
right (Autoscan on a 150mm wafer will start at 15mm). 

End: This is the position of the last point of the scan in terms of millimeters from left to 
right (Autoscan on a 150mm wafer will end at 135mm).

Bow: This is the maximum amount of deflection from zero amongst the fifty points of the 
scan with zero being a line drawn from the first to the fiftieth point. This is in terms of mm.

Laser: This is the selected laser for the scan. The 670nm is the Red laser, the 780nm is 
the Infrared laser.

Orientation: This is the angle of the wafer as entered by the operator for this scan.
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Load: This will open a different DAT file.

Save: Will save the current DAT file with the same name.

Save as: Will save the current DAT file and prompt a new 
name.

Restore: Will return the current DAT file to its previously 
saved state.

Merge: Allows the combining of 2 DAT files into one 
larger DAT file. Note that a single DAT file can only have 
up to 1000 records.

Print: Will print the spreadsheet of the current DAT file.

Close: Will exit the current DAT file.

5.2.1 Deleting Records
1. Highlight the rows to be deleted.

2. Go to the “Edit” tab with the DAT file open. Select “Delete” and press enter to 
delete. 

NOTE: The delete button on the keyboard will NOT delete these selected rows. 
The Right-Click and delete will NOT work either.
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5.2.2 Move Records
This feature is for moving records around within the DAT file. This function does 
not enable moving records from one file to another

1. Highlight the rows to be moved.

2. Select “Move” from the “Edit” tab of the DAT toolbar.

3. Double click on the record that is before where the highlighted records are to be 
placed. The records should immediately appear there.

5.2.3 Copying Records
This function works exactly the same as “Move Records”. This function does not 
enable moving records from one file to another.

1. Highlight the rows to be moved.

2. Select “Copy” from the “Edit” tab of the DAT toolbar.

3. Double click on the record that is before where the highlighted records are to placed. 
The records should immediately appear there.

5.2.4 Merging Data Files

1. With one of the data files to be merged 
open, go to the “File” tab and select 
“Merge”.

2. The list of DAT files within the folder 
will pop-up.

3. Select the other DAT file that is to be 
merged with the currently opened DAT 
file.

4. Click on the “Open” button. The records 
of this file will be merged into the 
beginning of the currently open file.
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5.2.5 Recalculating Stress
1. Change the film thickness or substrate thickness, or elastic modulus in a record that 

will be the first record in a group of records to be recalculated. Initially the Stress 
will be recalculated for just this record. In order to change a large group of records 
begin by editing the first record of the group.

Example shows the Sub-
strate thickness field being 
changed. The Stress calcu-
lation is done as soon as the 
new value is entered.

Example shows the new 
substrate thickness entered. 
Notice the recalculation of 
Stress.

2. Select the block of records, starting at the edited record.

3. When “Recalculate stress” is selected all of the changes in the first record of the 
highlighted records will be propagated to every record selected. All of the stress 
calculations will be redone.



FLX-2320-S Chapter 5 - Managing Data Files 58
7/10 TOHO Technology 58 

5.2.6 Converting a Single Scan to a First Scan
1. Highlight a record to be converted from a post deposition scan to a first scan.

2. Select “Edit” tab inside the Editor application window. Select “Create No film rec”

3. The “Stress” and “Film Thickness” fields will turn to “N/A”. This will be the new 
“most recent” First measurement. Subsequent scans with this Identity will refer to 
this record as the first scan. If the “ID” is changed, this new “ID” will be available 
in the drop down menu when doing scans within this folder. 

This feature is most useful for first scans mistakenly taken as single scans. It’s also 
very useful when seeking to measure stress between a previously applied deposition 
and a new deposition.
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5.2.7 EXPORTING DATA
1. Open a data file.

2. To export all of the data within the currently opened DAT file select the “Export” 
tab from the Editor Application window. 

3. Selecting “ASCII file-LOTUS” or “Text file - Excel” makes no difference. The 
software will only export files with a .TXT extension.

NOTE: “.TXT” files may be imported into 
Excel or other spreadsheet software. Excel 
is not provided with the Felxus 2320-S by 
TOHO;

ASCII (American Standard Code for Infor-
mation Interchange) Text file (.TXT) is an 
ASCII file.

4. Name the new file. The data will export to the User’s folder. Click ‘Save” and the 
files have been exported.

5. If choosing to save the data in rows only, the record fields of the data file appear 
as 14 consecutive rows. The row headings will not be exported unless the whole 
file is exported.
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6 CREATING AND DISPLAYING GRAPHS

This chapter describes the operation of the instrument. It describes how to create, edit, and 
display 3-D data, and plot graphs and trends.

6.1 CREATING 3-D GRAPHS
This section explains how to Select groups, tag and untag groups. This section also 
explains how to create Deflection, Radius, and Stress 3-D plots as well as manip-
ulate the image with Tilting, Spinning, Amplification, and color representations.

6.1.1 Creating a Deflection 3-D Plot.

1. On the main application screen select the “Analysis” tab. Click on “3D plotting”.

2. The screen will become the “PLOT3D Windows Application”. Go to the “File” tab 
and select “NEW”.
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3. Select “DEFLECTION Document” from the “NEW” window that appears. 

4. A Window will appear called “Group Selection Dialog”. It lists the “Start Records” 
for groups. A Start Record is the 1st record in a group. The number in the “Start 
Rec” column refers to the record number in the Editor Application for this folder.

5. For a Deflection graph only one group needs to be tagged. To Tag a record just 
highlight it and then press the “tag” button. An “F” (F is for First Measurements) 
should appear next to the Start Record Number. To Remove the tag, press the 
“Untag” button. Tagging One group “F” and another group “S” (S is for Single 
Scans) will produce a graph that depicts the difference in deflection between the 2 
groups.

6. Press “OK” and the graph will appear. This graph will have real time controls for 
Rotation (45 degree movements), Tilt (profile to top view), and Amplification.
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7. A Deflection map created from just one 
group marked “F” will give a map of the 
Deflection across the wafer. The map 
shown to the left was a group of First 
measurements. This graph represents the 
shape of the wafer before the deposition.

8. A Deflection Map created from just one 
group, but made of Single Scans will also 
be tagged with “F”. This graph created will 
represent the shape of the wafer after 
deposition.

9. A Deflection graph made from Tagging 
one group as a group of First Scans “F”, 
and another group of scans as a group of 
Single Scans “S” make a graph depicting 
the deflection between the 2 curvatures. 
This is how the deflection has changed 
from pre deposition to post deposition.
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6.1.2 Creating a Radius 3-D Plot

1. In the “PLOT3D Windows Application” go to the “File” tab and select “NEW”.

2. Select “RADIUS Document” from the “NEW” window that appears. 

3. A Window will appear called “Group Selection Dialog”. It lists the Start Records 
for groups. The number in the “Start Rec” column refers to the record number in 
the Editor Application for this folder.

4. For a Radius graph only one group needs top be tagged just like a Deflection graph. 
To Tag a record just highlight it and then press the “tag” button. An “F” should 
appear next to the Start Record Number. To Remove the tag, press the “Untag” 
button. Tagging One group “F” and another group “S” will produce a graph that 
depicts the difference in Radius between the 2 groups.
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5. A Radius map created from just one 
group marked “F” will give a map of the 
radius across the wafer. The map shown 
to the left was a group of First 
measurements. This graph represents 
the shape of the wafer before the 
deposition.

6. A Radius Map created from just one 
group, but made of Single Scans will 
also be tagged with “F”. This graph 
created will represent the shape of the 
wafer after deposition.

7. A Radius graph made from tagging one 
group as a group of First Scans “F”, and 
another group of scans as a group of 
Single Scans “S” make a graph depicting 
the radius between the 2 curvatures. This 
is how the radius has changed from pre 
deposition to post deposition.
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6.1.3 Creating 3-D Stress Plot
1. In the “PLOT3D Windows Application” go to the “File” tab and select “New”.

2. Select “STRESS Document” from the “New” window that appears. 

3. Tag the First Scan group with “F”. Tag the group of Single scans with “S”. Every 
time the “tag” button is clicked it will assign an F or an S to the record line currently 
selected. The same button oscillates between the 2 tags.

4. The graphic will specify the flat 
or notch orientation, but will not 
represent it. The image will be a 
circular wafer. The units of Dynes 
/ cm2 or MPa come from the 
Process Program.
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6.1.4 Manipulating 3-D Graphs
The graphs will pop-up with an isometric view. The tool buttons on the top of the 
window can adjust Tilt, Spin, and Amplitude.

1. This button opens the “NEW” window, for creating 
a new Stress, Radius, or Deflection Document.

2. This button will open a previously created and saved 
graph.

3. This button will save the current graph.

4. Tilts the graph towards the User (towards Top View)

5. Tilts the graph away from the User (towards Profile) 

6. Rotates graph 45 degrees Counterclockwise.

7. Rotates graph 45 degrees Clockwise.

8. Turns down the amplitude of the graph (flattens)

9. Turns up the amplitude of the graph. 

10. Prints current graph.

11. About Plot 3D: Gives the current version of the 3D 
software.

12. Help: Currently not an active feature.
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The Tilt feature is controlled 
by these 2 buttons.

This view is a Stress Map tilted all the way up.

There are only 4 angles the graph can be tilted at. 
This is one of the middle angles, on the profile side.

This is the angle that is one step away from a top 
view.

This is the top view of the wafer.
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6.2 Creating Graphs from Data Files
Use this option to create graphs from the raw data files. You have the option of creating 
a graph from the entire data file or from a selected block. Without a data line (record) 
selected the software assumes to use the entire data file.

6.2.1 To create a graph:
1. Open the Editor Window and select the “.DAT” file that contains the data to be 

graphed. 

2. If using the entire DAT file then proceed to the “graph” tab and select “Create”.

3. If using only certain records, select a block by highlighting them, then go to the 
“graph” tab and select “Create”.

A window will appear with several options.
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Field Description

Graph Label The label to be displayed above the graph. You can enter 
any combination of characters and numbers.

X The X-axis of the graph (left to right). Choices available 
from the drop-down list are Time, Stress, Bow, Record 
Number, Temperature, and Light Intensity. If you select 
Time or Stress, an additional field is displayed next to the 
field to allow you to enter Initial Time or Stress respective-
ly. 

Y The Y-axis of the graph (up and down). Choices available 
from the drop-down list are Stress, Bow, Record Number, 
Temperature, and Light Intensity. If you select Time or 
Stress, an additional field is displayed next to the field to 
allow you to enter Initial Time or Stress respectively.

Initial Stress

Initial Time

When one axis is Time or Stress, there will be a button that 
appears in case you want to create an offset for the graph. 
Initial time is entered in hours and minutes, and initial 
stress in MPa or dynes/cm2. MPa or dynes/cm2 is deter-
mined by the most recently opened Process Program. 

Modulus Correction To apply the modulus correction to the data, choose the 
Modulus Correction button. The dot in the center of the 
circle indicates that this option is activated; to not apply 
the Modulus Correction, choose the Modulus Correction 
button until the circle in the center of the button disappears.   

Autoscale Axis  Autoscale is the default. Once Autoscale Axis is unselect-
ed, additional options will appear.

X From: Starting X value.

Y From: Starting Y value.

X To: Ending X value.

Y To: Ending Y value.

X Step: Distance between grid markings on the X-axis.

Y Step: Distance between grid markings on the Y-axis.

Create Graph Creates a graph.

Cancel Cancels the application.
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4. The image below shows the “Auotscale axis” button unselected. The default for 
each field is “0”. With “Autoscale axis” unselected, it is important to enter values. 

5. The default for each field is “0”. With “Autoscale axis” unselected, it is important 
to enter values. If left at zero an error window will appear:

6. If this happens, simply click “OK”. Then select “Autoscale axis” or enter values.
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7. Click the “Create Graph” button. A graph will appear.

In the image above notice the offset is 45 MPa. This will be the value of the first 
scan selected and the subsequent plots will be relative to this first plot.

For graphs other than Temperature the plots will be Blue circles connected by a 
blue line by default.

Notice when Temperature is selected, increasing temperatures will be denoted by 
Red triangles, cooling temperatures are denoted by Blue circles.

8. To save the graph, choose Save As or Save from 
the “File” tab. When a graph is first created and 
unmanipulated only “Save As” is available. 
“Save” is available after the initial graph is 
changed (points, lines, colors, smoothing, etc.)
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6.2.2 Graph Options

You have the following options in the File tab menu: 

Load: Loads a previously saved graph. This will not open a new window. This will 
replace the existing graph window with this graph. (Press Restore, to return to the 
original graph)

Save: This is grayed out initially when a graph first appears. This is used when a 
graph has been manipulated, in order to save the changes to it.

Save as: Saves the graph as a GRP file.

Restore: Use this to return the graph to its original state.

Merge: Graphs may only be merged if they have the same attributes. (e.g. a Stress/ 
Temperature graph may only be merged with another Stress / Temperature graph)

The Graph on the Left is a Stress/Temp graph. The graph on the Right is that same 
graph merged with another Stress/Temp graph.

Print: Will print the graph only, not the 
screen.

Delete: Deletes the graph from this 
folder. It will open a window called 
“Open”, when you select the file in the 
“Open” window it will be deleted.

Close: Closes the graph.
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6.2.3 Font Options
The following options are available under the “Font” tab:

Set: Allows changing of the Graph Header, Axis Header, Axis Label, Subtitles 
(Points does nothing under the Font tab. Go to “Points” tab to manipulate the 
appearance of the Points on the graph.)

Save: Will change the default for font style, underlining, and color for the Graph 
Header, Axis Header, Axis Label, and Subtitles to the current selection. Future 
graphs will then have these settings as the default.

Restore: Will return the font settings to the last Saved style.
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6.2.4 Points Options

Color: Select Color from the Points 
tab, then click. The menu will dis-
appear. Bring the cursor over to the 
graph. It should change from the 
standard arrow into a cross.

Bring the cross onto the graph and 
click on one of the points of the 
graph. A color pallet will appear.

After the new color is selected, 
click on “OK” and the new color 
will be applied to the points and the 
connecting line (if present).
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Shape: The default shape for the points on the graph are circles.

• Rectangle

• Circle

• Triangle

• Star

• Cross

• Dot      

Dot: Selecting “Dot” is like selecting no point markings. There will be a single 
pixel at each data point with “Dot” selected, however this is most likely used when 
the points are “connected”. The example below has the Blue Line with “Dot” 
selected, and the Red Line with “triangle” selected. Both lines are “connected”.

Connect: This selection will connect as well as disconnect. Once selected the cross 
will appear. Move the cross to the graph and click on a point of the line to be 
connected or disconnected. This will connect (or disconnect) all of the data points. 
A straight line will be drawn (or removed) between each data point progressing left 
to right.
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6.2.5 Axis Scale Options

Axis Scale: Will stretch the graph within the graph window.

Top left: Select “Top Left” from the Axis scale tab. The cursor will become a cross. 
Move the cross to the desired top left corner of the graph area. The graph will stretch 
accordingly.

Bottom Right: Select “Bottom Right” from the Axis scale tab. The cursor will 
become a cross. Move the cross to the desired bottom right corner of the graph area. 
The graph will stretch accordingly.

Place the cross in 
position for the 
bottom right, then 
click to stretch the 
graph. 

Place the cross in 
position for the top 
left, then click to 
stretch the graph. 
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6.2.6 Curve Fitting
Curve Fitting will express the graph or part of a graph as a mathematical function. 

“Linear” gives the function of a line.

“Order 2" gives the function of a curve.

“Order 3" gives the function of a complex curve 
(an “S” shape) 

1. For a Linear curve fit, select “Linear” from the Curve fitting tab.

2. The cursor will become a cross. Click on the start and the end point for the portion 
of the graph to be expressed as a linear function.

In the example above, the section from 70 oC to 150 oC was selected. The function 
between these 2 points is graphed. The mathematical equation will appear above 
the graph. (To change the font or color or style modify “Subtitles”)

The equation given reads “5.556 + -5.35E-02*x^1”. 

This is more commonly expressed as: y = -.0535x + 5.556
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1. For an Order 2 curve fit, select “Order 2" from the Curve fitting tab.

2. The cursor will become a cross. Click on the start and the end point for the portion 
of the graph to be expressed as a single curved function.

In the example above, the section from 30 oC to 170 oC was selected. The function 
between these 2 points is graphed as a single curve. The mathematical equation 
will appear above the graph.

The Equation reads “-4.00 + 0.1213*x^1 + -7.59E-04*x^2”

This is more commonly expressed as: y = -0.000759x2 + 0.1213x - 4



FLX-2320-S Chapter 6 - Creating & Displaying Graphs 80
7/10 TOHO Technology 80

1. For an Order 3 curve fit, select “Order 3" from the Curve fitting tab.

2. The cursor will become a cross. Click on the start and the end point for the portion 
of the graph to be expressed as a double curved function.

In the example above, the section from 70 oC to 200 oC was selected. The function 
between these 2 points is graphed as a double curving function. The mathematical 
equation will appear above the graph.

The Equation reads “-36.46 + 1.00*x^1 + -8.28E-03*x^2 + 2.04E-05*x^3”

This is more commonly expressed as:

 y = -0.0000204x3 - 0.00828x2 + 1x - 36.46
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NOTE: Curve color does nothing. It will open a color pallet, but 
selecting a color and pressing “OK” does nothing.

To change the color of the curve go to 
the “Points” menu, select color, then 
click the cross on a section.

This will change the color of the 
curve on that graph and the color 
of the font for the equation.
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6.2.7 Smoothing
Use the Smoothing menu to reduce the amount of noise found in a graph. Smoothing can 
be performed for three, five, seven or nine points.

The image above shows a graph before any smoothing has been applied. Notice the first 
3 points have temperatures of 22oC, 31oC, and 42oC.

The image below shows this same graph with 3-Point smoothing applied. The software 
takes the average of the nearest 3 points at every point to plot the smoothed graph. Notice 
there are now fewer points. The 1st point is now the average of what were the first 3 points 
of the original graph. 

The new 1st point is now at 32oC. (22+31+42=96; 96/3= 32 average)
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5-point smoothing

The image below shows this same graph with 5-Point smoothing applied. The software takes 
the average of the nearest 5 points at every point to plot the smoothed graph. Notice there 
are now fewer points. The 1st point is now the average of what were the first 5 points of the 
original graph.

The new 1st point is now at 45oC. (22+31+42 +58 + 71 =225; 225/5= 45 average)

7-point smoothing

The image below shows this same graph with 7-Point smoothing applied. The software takes 
the average of the nearest 7 points at every point to plot the smoothed graph. Notice there 
are now fewer points. The 1st point is now the average of what were the first 7 points of the 
original graph.

The new 1st point is now at 58oC. (22+31+42 +58 + 71 +83 + 98 =406; 406/7= 58 average)
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9-point smoothing

The image below shows this same graph with 9-Point smoothing applied. The software takes 
the average of the nearest 9 points at every point to plot the smoothed graph. Notice there 
are now fewer points. The 1st point is now the average of what were the first 9 points of the 
original graph.

The new 1st point is now at 71oC. 

(22+31+42 +58 + 71 +83 + 98 + 111 + 122=639; 639/9 = 71 average)

The new last point is now 148oC.

(98 + 111 + 122 + 134 + 146 + 160 + 174 + 187 + 200 = 1332; 1332/9= 148 average)
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6.2.8 Setting the Colors of a Graph
Use the Color menu to set or change the color of the background, axis frame, grid, or plot 
area of the graph.

The image to the left has: 

Orange background

Blue Axis Frame

Violet Grid

Custom Yellow Plot Area

To change the background color:

1. Choose Background from the Color menu. 

2. The color dialog box displays. Select the desired color and click OK. Then the graph 
re-displays with the selected background color.

To change the axis frame color:

1. Choose Axis Frame from the Color menu. 

2. The color dialog box displays. Select the desired color and click OK. Then the graph 
re-displays with the selected axis frame color.

To change the grid color:

1. Choose Grid from the Color menu. 

2. The color dialog box displays. Select the desired color and click OK. Then the graph 
re-displays with the selected grid color.

To change the color of the plot area:

1. Choose Plot Area from the Color menu. 

2. The color dialog box displays. Select the desired color and click OK. Then the graph 
re-displays with the selected plot area color.
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6.3 CREATING A TREND PLOT
Use this option to plot trends from the raw data files. You have the option of generating 
a trend plot from the entire data file or from a selected block.

To generate a trend plot: 

1. Display a data file in the Data Editor window:

• Choose Trend Plot from the Graph menu in the Data Editor window. 

• A window will appear.
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• Enter values for the fields using the following list. 

Field Description

Graph Label The label to be displayed at the top of the trend plot. 
You can enter any combination of characters and 
numbers.

Y axis The Y-axis is set to Stress and cannot be changed.   

X axis The X-axis of the graph. Choices available in drop 
down menu are Record Number, Date, and Days. 

Calculate STD  
deviation

Calculates the standard deviation.
 (standard deviation is the square root of variance). 
This is selected by default. Click on this to unselect 
this feature. Fields for Upper SL and Lower SL will 
appear.

Upper SL The Upper Specification Limit in MPa or dynes/cm2.
The selected units of Stress MPa or dynes/cm2 is 
determined by the most recently opened Process 
Program. 

Lower SL The Lower Specification Limit in MPa or dynes/cm2.
The selected units of MPa or dynes/cm2 is deter-
mined by the most recently opened Process Program. 

Autoscale Autoscale is selected by default. Click on this to 
unselect this feature. Fields for X from, X to, X step, 
Y from, Y to, and Y step. 

X From: Starting X value.

Y From: Starting Y value.

X To: Ending X value.

Y To: Ending Y value.

X Step: Distance between grid markings on the X-axis.

Y Step: Distance between grid markings on the Y-axis.

Out of limits When clicked gives the record numbers and Stress 
data for scans outside of the standard deviation or 
specified Upper and Lower Limits.

Trend plot Creates a graph with calculations for the average and 
standard deviation (Sigma).

Cancel Cancels the application.
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2. With “Calculate STD deviation” 
unselected, fields for Upper and 
Lower Stress Specification will ap-
pear. Enter these limits. 

3. The Upper SL and Lower SL will be displayed in the graph when the “Trend plot” is created.

4. Cpk is a simple number which mea-
sures how close a process is running 
to its specification limits, relative to 
the natural variability of the process. 
The larger the index, the less likely 
it is that any item will be outside the 
specs.

5. Cp is Process Capability. Defined as 
(USL - LSL)/6*Std.Dev
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Cpk is defined as the lower of Cpl and Cpu where   

Cpl Average LSL–( )
3σ

------------------------------------------- Cpu, USL Average–( )
3σ

--------------------------------------------= =

 and,   

Cp Cpu Cpl+( )
2

-------------------------------=

  

If the option to calculate the standard deviation was selected in the Graph window, 
then σ and the average are displayed above the trend plot. Also, note that in the plot

• points within ±σ limits are plotted as squares,

• points within the ±3σ limit but outside the ±σ limits are plotted as circles, and 

• points outside the ±3σ limits are marked with an X.

To display a table of the points outside the specification limits, choose “Out Of 
Limits” from the Trend Plot dialog box. A table of the outlying points displays. 

NOTE: This window will only display up to 12 records at a time. The window will not 
expand. Use the scroll bar to see the remaining records.
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6.  With Autoscale unselected, se-
lect range for the X axis of the 
graph (record number, date, or 
days).

7.  Enter beginning and ending 
points (in terms of Stress) for the 
Y axis.

8.  Only the specified range will 
appear.

9.  All of the same graph options 
apply to Trend Plots. (Font, 
Points, Axis Scale, Curve Fit-
ting, Smoothing, Color.)
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7 DATA ANALYSIS

This chapter describes how to analyze the data by displaying graphs of file subtraction, 
thermal stress, elastic and expansion coefficient calculations, and diffusion coefficients.

NOTE: “Graph retrieval, Record comparison, and 3D plotting” have been covered earlier 
in this manual.

7.1 DIFFUSION COEFFICIENT
To calculate the diffusion coefficient:

1. Choose Diffusion Coefficient from the Analysis menu.

2. The system displays a dialog box prompting for the desired filename.

3. Enter or choose the desired filename. Be sure to select a Time- Stress graph.
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4. If a graph is selected that is not a Time-Stress graph, an error window will appear.

5. When a Time-Stress graph is selected a graph displays. Notice in the bottom of the 
screen the user is prompted to select two points on the graph by double- clicking 
on the points. 

It is very possible that two of the 
points selected will not converge. If a 
message appears “No Convergence” 
simply select two different points.

For details on the equation used to 
calculate the diffusion coefficient, see 
Chapter 9, “Theory of Operation.”
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6. When the two points do converge, an equation will appear with a graphed function.

In the example the Initial Stress reading is “2.250E+001 MPa”

This is more commonly expressed as 22.5 MPa

The initial stress reading is where the stress would be on this curve at time Zero.

In the example the Final Stress reading is “ -4.983E+001 MPa”

This is more commonly expressed as -49.83 MPa

The Final Stress reading is the asymptotic stress value that the curve “settles” at.

The diffusion coefficient is calculated by the least square fitting to the diffusion equation 
into a finite film:

σ σ0 ∆σ 1 8
π2
----- 

  1
2n 1–( )

-------------------- 
  2 1 2n–( )2

4L2
----------------------π2Dt

 
 
 

–exp
1

∞

∑––=

where
σ  is the stress at time t
σ0  is the initial stress
∆σ  is the total stress change after completion
n is a running index from 1 to infinity
L is the film thickness
D is the diffusion coefficient
t is the time
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7.2 ELASTIC AND EXPANSION COEFFICIENT CALCULATION
The Expansion and Coefficient option under the Analysis menu calculates the film thermal 
expansion coefficient and biaxial modulus. 

The stress change with temperature in the elastic range is governed by the following 
equation:

dσ
dT
------ E

1 v–
----------- 

 
f

αs αf–( )=

where
dσ
dT
------  is the derivative of stress versus temperature

E
1 v–
----------- 

 
f
 is the biaxial modulus of the film

αs  is the substrate thermal expansion coefficient
αf  is the film thermal expansion coefficient

The above equation has two unknowns—αf  and E
1 v–
----------- 

 
f
. To solve these, two temperature 

cycles are done with two different substrates and the software solves two equations. 

To display a graph of the elastic and expansion coefficient calculation:

1. Use the Stress-Temperature mode to run two temperature cycles on two different 
substrates with the same film. 

 For best results use slow heating or cooling (<5o C per minute) to minimize
the lag of the wafer temperature behind the heating stage. 

Use the procedures in “Creating Graphs,” to create and save graphs for both the data 
files.

2. Choose Elastic & Expansion from the Analysis menu.

3. The following dialog box displays: 

 NOTE :
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4. Either tab or mouse over to the “Files” button, in order to select graph files.

5. The “Open” window will display all of the GRP (graph) files under the current User.

NOTE : graphs have to have the same attributes and only one temperature ramp.

6. When two proper graphs are selected, and the “OK” button is clicked. Three 
windows will appear. The top window will be “Average coefficients”. This window 
may be moved around, however the other graphs windows will not move until the 
“Average coefficients” window is acknowledged by either closing or pressing 
“Cancel”. This shows the average values of the expansion coefficient and the biaxial 
modulus.
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7. The “graph” window will plot the two Stress/Temperature graphs on the same 
graph.

8. The “Linear thermal expansion coefficient” graph gives the coefficient and Biaxial 
Modulus as averaged between the two graphs.
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7.3 GRAPH SUBTRACTION
The graph subtraction feature is used for 

• Simple graph subtraction for comparison or correction, and

• Multiple films on the substrates

In the case of multi-film use, measure the wafer with Film 1 (thickness t1) using the Stress- 
Temperature method and create a graphic file called File 2. Assume the stress measured 
for this film is σ1 . Then measure the wafer with Film 1 + Film 2 (thickness t2) and create 
a graphic file called File 1. Note: Use the same temperature recipe for both graphs. The 
stress of the film with Film 1 + Film 2 is   

σ
σ1t1 σ2t2+( )

t2
--------------------------------=

σ1t1
t2

---------- σ2+=

As σ1 was measured in File 2,σ2 is calculated by subtracting σ1t1
t2

----------  from File 1. This is done 

by inserting the value of t1
t2
---- as the multiplier of File 2 as σ2  = File 1 – t1

t2
----  x File 2. Note that 

this equation and procedure are valid only if the Film 1 stress is not affected by Film 2.

To subtract graphs: 

1. Choose Graph Subtraction from the Analysis menu. The following dialog box 
displays: 
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2. Click on the field next to “File 1". Once the cursor is there enter the file name for 
the 1st graph to be subtracted from. To see a list of available graphs (under the 
current User) click on the “Files” button. An “Open” window will appear with all 
the files available.

3. Click on the “Open” button. The graph file name should appear in the “File 1" field.

4. Repeat this process for the “File 2" field. This is the graph to be subtracted.

5. With the two File paths entered 
into the fields, name the new 
graph in the “New graph” field. 

6. Selected Curve smoothing will 
have a filled circle and a 
“Curve smoothing Y”. Unse-
lected will be an empty circle 
and read “Curve smoothing N”. 
Curve smoothing reduces 
noise. Curve smoothing is nec-
essary if the 2 graphs have a 
different number of points.

7. Click “OK” to create new graph.

100
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8. Two windows will appear: 1) The two graphs superimposed on each other in 
differing colors and 2) The subtracted graph.

9. Use the multiplier fields if the films of the 2 plots are different thicknesses. (e.g. 
File 1 has a film thickness of 5,000 angstroms and File 2 has a film thickness of 
10,000 angstroms.

10. Choose Save from the File menu to save the graph.

101
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7.4 Thermal Stress

Use the Thermal Stress option to display the thermal stress superimposed on the stress-
temperature measurement data.

To display the thermal stress 
superimposed on the Stress-
Temperature graph:

1. Choose Thermal Stress 
from the Analysis menu. 

2. The following dialog box displays: 

3. Enter the path and name of the file and press ENTER, or choose the Files button to 
display a list of available files. To change the directory to another User’s, use the 
drop down menu “Look in” in the “Open” window.

4. Enter the From temperature and To temperature values. Press TAB to move to 
the next field.

5. Enter the Substrate material name. Enter the desired substrate name, or use the 
drop- down menu to select the desired substrate. Press TAB to move to the next field.

6. Enter the Film material name. Enter the symbol, for example, W for tungsten, or 
use the pull-down menu to select the desired film material. Choose the OK button 
or press ENTER to measure the thermal stress.



FLX-2320-S Chapter 7 - Data Analysis 103
8/10 TOHO Technology 103

This is an example of film tungsten (W) on Permalloy.   

7. Click on a point of the graph and the Thermal Stress linear graph will appear 
intersecting (in Red) on this point.

8. Choose Save from the File menu to save the graph.

7.5 Comparing Records
The Record Comparison option in the Analysis menu compares the curves of the first 
stress and single stress measurements. You can use this option only if you selected the 
option to save scan (extension.SCN) files when scanning the wafer in First Stress and 
Single Stress Measurement modes. Also note that the Stress-Time and Stress-Temperature 
Measurement modes do not create scan files. You can compare Deflection, Light Intensity, 
Stress Segmentation, and Stress Uniformity. You may also export the angles for each point 
of the scan.

To compare records:

1. Choose Record Comparison 
from the Analysis menu. 
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2. An “Open” window will pop up. 
Select from all of the scan files 
(SCN) under this User.

3. When the SCN file is opened, all 
of the records therein will display. 
You must “Tag” a “First” scan as 
well as a “Single” scan. The First scan must be a no thickness scan. Under the “Film 
Thick” column it will read “N/A”.

You can use the Edit menu to select tagging, or you may enter “Ctrl + F” for First 
scan and “Ctrl + S” for Single scan. An F appears next to the record indicating it is 
selected as the first measurement. To untag the record, choose Untag (Both) or press 
CTRL+U from the Edit menu.

4. To edit a record, use TAB to move to the record. You can edit the ID, Film Thickness 
(if measured), and Substrate Thickness fields. 
 

                NOTE :  To select and display only one record, tag only one record as First or Single
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7.5.1 Deflection
1. After selecting the two records, choose 

Deflection from the menu.

2. A pop-up window will ask whether or 
not to export the data to a file for every 
one of the 50 points. The file goes to 
C:\ WINFLX\File Export. It is stored 
as a “.TXT” file.

3. A deflection graph similar to the following displays: 

In the plot, 

• the deflections of the first measurement are plotted as circles,

• the deflections of the second measurement are plotted as rectangles, and 

• the difference between the two measurements are plotted as triangles.
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7.5.2 Light Intensity
1. After selecting the two records, choose “Light Intensity” from the menu.

2. An Intensity graph similar to the following displays: 

In the plot, 

• the intensity at each point of the first measurement is plotted as circles,

• the intensity at each point of the second measurement is plotted as rectangles, 

• the difference between the two measurements is plotted as triangles.

(The software always subtracts the 1st measurement from the 2nd measurement. 
The negative value is the same difference as a positive difference.)

7.5.3 Stress-Segmentation

1. After selecting and tagging 
the two records, choose the 
Stress tab.

2. Select Segmentation from 
the Stress tab.
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3. A Deflection graph similar to the following displays: 

(All of the graph options apply, see section 6.2)

4. The 1st point will be blinking. Use the arrows on your keyboard to navigate through 
the graph.

5. To delete a point press “D” when the point is blinking.

6. To calculate the Stress and the Radius press “ENTER”.

This graph

does not have any points deleted
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7. The same graph with some points deleted will have a different result:

7.5.4 Stress-Uniformity
1. After selecting and tagging the two records, choose the Stress tab.

2. Select Uniformity from the Stress tab.

3. A window will appear. It will have the location for 5 points. Each point has a field 
for location, film thickness, and substrate thickness.
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4. Once the points are adjusted for Location, film thickness, and substrate thickness, 
press the “Calc stress” button to calculate the Stress.

(All of the graph options apply, see section 6.2)

7.5.5 Angles
1. After selecting a record and tagging it “First” (F)

2. Select the “Angles” tab. Then select “Export”.
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3. A “Save As” window will appear. Choose file name for the .TXT file being created.

4. The data will go to the file saved under the current User selected under WINLFLX.

5. The data will be the scan #, the position across the wafer in hundredths of a 
millimeter, and the Radian (angle). [ 0.00000 = a perfect 90 degrees ]
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8 Maintenance

This chapter is intended for the key person responsible for the maintenance of the TOHO 
FLX-2320-S instrument. The following information is provided in this chapter:

• Calling TOHO Service and other related information

• Getting information about the hardware using the Utilities Menus

• Verifying the calibration of the instrument

• Troubleshooting minor problems

• Moving the laser beam, checking the laser’s travel is centered

• Using Calibrated Wafer Sets

• Using Calibrated Mirror Sets

8.1 SERVICE POLICY
The TOHO Instruments Service Organization is available to you in the United States, 
Europe, and Japan. We also have representatives in The People’s Republic of China and 
Taiwan.

TOHO Technology’s commitment is to provide a technical response by telephone within 
24 hours, often within the same business day.

• The service organization is available for installing your instrument. To schedule the 
installation, contact the Customer Service Administrator.

• In the United States, service requests are processed through a central number located 
in Illinois.     Call 773-583-7183 Monday through Friday between 7:00 A.M. and 
7:00 P.M., Central Time, to arrange for service or repair work or to order replacement 
parts.

• Standard on-site service hours are Monday through Friday, 8 A.M. to 5 P.M., local 
time. You can arrange for other hours through a customized service contract.

• TOHO Technology provides service beyond the original warranty period of 1 year 
as needed. Repair work performed after the original warranty expires is guaranteed 
for 3 months. Full service contracts extend the warranty period and can be custom-
ized to your specific requirements.

TOHO Technology encourages you to attend a maintenance and repair training course for 
your instrument. In general, trained customers experience greater instrument uptime and 
make better use of TOHO Technology service resources. Your sales or service engineer 
can provide you with the course and fee schedule.
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8.2 MAINTENANCE
Use the procedures in this user manual to maintain the components as required. Note the 
following:

• The Stress readings should stay within 5% accuracy as compared to a calibrated 
wafer set. (The radius measurements will not necessarily be within 5%)

• The flatter the substrate the greater the radius, the instrument is interpreting flatness 
as a radius, so large radii will not be within a percentage. (For example, a reading 
of 9,000 meters is very similar to a reading of 5,000 meters.) However at approxi-
mately a 20 meter radius, the instrument should read within 5%.

• The 20 meter curved mirror should read within 5% (1 meter) of the certified radius.

• The Flat Mirror should read a larger radius than 3000 meters. (note: -3000 meters 
is just as flat as 3000 meters.)

• The instrument could require cleaning or adjustment if the reflected light intensity 
is consistently low. Call TOHO Technology Service to schedule the necessary 
maintenance; do not attempt to clean or adjust the instrument yourself. However, 
before calling TOHO Technology, use the procedures in section 8.3, “Troubleshoot-
ing,” to make sure that the low light intensity is not caused by any of the listed 
reasons.

• The instrument should be calibrated by a TOHO Technology technician once a year. 
Do not calibrate the instrument yourself; only TOHO Technology Service should 
calibrate the instrument.
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8.3 TROUBLESHOOTING
If the measured intensity is zero or low, do the following before calling TOHO Technology:

• Make sure the instrument is turned on.

• Make sure a sample is loaded and the sample is reflective. 

• Make sure the wafer is sitting flat on the 3 ball bearings.

• Make sure the beam is impinging on the substrate by using the following procedure:

1. Place a bare silicon wafer on the stage.

2. Go to the “Utilities” Menu from the main screen.

3. Select “Laser Intensity/ Move Laser”

• You can select 670nm, 780nm, or both lasers. 

• The intensity for the 670nm laser (red or vertical) is nominally 3.08, the spec is 
from 2.58 to 3.58.

• The intensity for the 780nm laser (yellow or horizontal) is nominally 2.75, the spec 
is from 2.25 to 3.25.

• The nominal intensity for both lasers is 3.08 + 2.75 = 5.83.
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4. Position: Position refers to the position on the detector. The nominal position 
(DIFF) is 0.000. The tool is in spec from -0.100 to + 0.100.

5. Set Laser at Center: When this Utility Menu is opened the tool will automatically 
move the laser to the center of travel across the wafer. This button is used as a reset 
in case you’ve moved the laser.

6. Move to desired distance: This field lets you enter a relative distance in terms of 
millimeters for the laser to move. Negative numbers will move to the left, positive 
to the right. This is a RELATIVE movement. It is possible to command the laser 
beyond its stroke and jam the motor. Be very wary of the laser’s position before 
you give it a command! There is a graphic that will indicate where the software 
believes the laser is pointing.

8.4 DIAGNOSTICS
Use the Diagnostics option to get hardware information such as laser position, and reflected 
light intensity. 

1. PC Ports Diagnostics & Laser Status:

• Select the “PC Ports Diagnogtics & Laser Status” selection from the 
Utilities Menu. This will show the DIFF (position on the detector) and the 
intensity for both lasers simultaneously.

• 0 Serial Ports installed: Tells you the communications with the PC is OK.

• Motor functioning: Tells you the feedback from the motor encoder is OK.

• Table Leveling: Refers to the stage. If this Utility Menu says “CW” 
(clockwise) or “CCW” (counter-clockwise) it is referring to the thumb screw 
that used to be adjustable. Toho recommends NOT adjusting the thumb 
screw. The leveling was done at the factory and is locked in place. This 
reading in this Utility Menu usually means the wafer isn’t sitting flat on the 
3 ball bearings.
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8.5 CALIBRATION
The TOHO Technology FLX-2320-S should be calibrated once a year. Schedule an 
appointment with TOHO Technology Service to calibrate the instrument. 

8.6 RADIUS OF CURVATURE VERIFICATION
Note that the following procedure is optional. Before each instrument is shipped, its radius 
of curvature is verified and a Certification of Accuracy is included with the instrument. 
This calibration option is only available for the 6-in. and 8-in. wafer instruments.

8.6.1 Calibrated Mirror Verification: 
If the user has purchased the optional mirror set, they can set the appropriate Process 
Programs and measure the mirrors. The mirror set should come with a Certification. 
The 20meter (approximately 20 meters, spec sheet should specify exact radius e.g. 
19.96m) should measure within 5% of the nominal value.

1. Set up a Process Program for the mirrors. They are typically 100mm in diameter 
and 12,700 mm thick (substrate thickness). The picture below is the bottom of a 
radius 20meter mirror. Its actual radius is 19.960m. Its actual substrate thickness is 
12,850mm. It also has a serial number that ties it to its Certification Record. It’s 
recommended practice to write this information on the bottom of the mirrors.

CAUTION: The following procedures are for verification only. Do not attempt 
to calibrate the instrument yourself. If your test values fall outside 
the specified ranges, call TOHO Technology Service. However, 
before calling TOHO Technology, use the procedures in Section 8.3, 
“Troubleshooting,” to make sure that the low light intensity is not 
caused by any of the reasons listed.
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2. Place the Mirror positioning ring on the stage. The mirror positioning ring has a 
square cutout. There’s a hash mark you want to face up. The hash mark will be to 
the left. This will line up with a hash mark on the side of the mirrors. This is so you 
always measure the same diameter. Locate the mirror in the corner of the square 
that is far and to the left of the user.

• The 3 notches will locate to the 3 pegs on the stage.

• Place the flat or concave mirror, face up, into the center of the mirror ring. 
Position the mirror so that the positioning line on the mirror matches the 
positioning score on the mirror ring. Also, move the mirror so that it touches 
the mirror ring on the left and the back.

The mirror line 
and the ring score 
are aligned.

Mirror

Mirror 
Positioning 
Ring

This section of the 
positioning ring 
should be towards the 
front of the 
instrument.

The mirror touches 
the mirror ring on the 
left and back.
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3. Perform a First Measurement:

• See Chapter 3 Section 2 for Process Program setup.

• Be sure the Diameter = 100mm and the Thickness is correct (e.g. 12,850mm).

• Instead of creating another Process Program, you may simply switch mirrors and 
and re-scan (be careful the Thickness is correct).

• If the thickness of the other mirror is different, simply enter the new thickness in the 
“Substrate thickness” field and then press the “Measure” button.
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The Certification of Accuracy certifies the radius of curvature for the instrument. It includes 
information such as the customer name, the date the test was done, the type of test done, the 
reference standards used, and the certified results. 

 Toho Technology Corporation 

Certificate of Accuracy 
Customer:   
Customer Order No.:   
Item Tested:  Concave Mirror（Thickness１２．７ｍｍ） 
Part No.:  236349   Serial No.: 0408-0115 
Type of Test Performed: Optical Lever Cantilever Beam technique 
Certified Results 
Radius of Curvature  ----   19.960 ｍ 
Standard Deviation   ----    0.036 ｍ 
 
Reference Standards Used: 
Toho Technology Thin Film Stress Measurement System with Zygo certified 19.532m 
Radius of Curvature Concave Mirror 
 
Laboratory conditions during the test 
Temperature:  ２５℃ 
Toho Technology certifies that the data consist of 10 measurements made under conditions specified 
producing the results reported.  The result reported is the average of these measurements.  
Although NIST radius traceable standards do not exist, the Zygo Mark IVxp Interferometer with 
Zygo Axiom 2/20 DMI S/N 87-51-0028 used for certification Toho Technology 19.532m Radius of 
Curvature Concave Mirror was calibrated using other NIST traceable standards (731/244084-89).  
Toho Technology Thin Film Measurement System used for the certification was calibrated using 
19.532m Radius of Curvature Concave Mirror S/N M0402-0088. 
       
      Signed Hidetoshi Suzuki 
      Title Test Engineer 
      Date Jun 04, 2008 
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8.7 Stress Accuracy Verification Test
8.7.1 Calibrated Wafer Set

If the user has purchased the optional calibrated wafer set, they can set the appropriate 
Process Programs and measure the calibrated Stress. The mock Stress should read 
within 5% of the Certified Stress

1. Set the Process Program up for your Wafer set. be sure to use the thickness and 
diameter from the Certification.

2. Use Wafer A for the First Scan. Perform scan then close (cancel) the First Scan 
Window.

3. Exchange Wafer A for Wafer B. Select “Single Scan” from the “Measure” tab. 
Select the ID from the drop down menu that is the same ID that was used for the 
First Scan for wafer A.

Enter the film thickness specified on the 
Certification. Typically it is 10,000 ang-
stroms. (10000 A)

The resulting Stress should be within 
5% of the Certified Stress if the tool is 
in calibration.

Take note that the flat or notch oriented 
to the right is considered 0 degrees. 
(Like the origin in Geometry). The flat 
away from the user is considered 90 
degrees (rotating counter clock wise).

Wafer is at 0 degrees Wafer is at 90 degrees
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CERTIFICATION OF ACCURACY 
(SET CERTIFIED WAFERS, 200MM DIA) 

 Tested: 
ho P/N  Description         QTY 
6070  Set, Certified W afers, 200 DIA, FLX, consist of 
053  W afer Assembly, Bare, Silicon, 200 mm      1 
031  W afer Assembly, Certified, 200 mm            1 

e of Test Performed: 
Given that a single radius measurement can be variable, the best way to ensure long term 

eatable correlation or consistent SPC numbers is to use two stable wafers.  The best choice is to 
 a blank silicon wafer marked as Wafer A  and thermal oxide film wafer marked Wafer B.  The 
ius of curvature between these two wafers should be sufficiently different so that the stress 
culation will be meaningful (≥150 MPa).  The following procedure describes the details. 
1. Measure W afer A using the First command in the Measure menu of the W INFLX software.  

ter an appropriate wafer thickness and use the same thickness on every machine. 
2. Measure W afer B using the Single command in the Measure menu of the W INFLX software. 

e the same wafer ID as used for W afer A, allowing the system to calculate from the difference in 
fers A and B.  Use a 10,000Å phantom film thickness for W afer B on all correlation or stability tests. 
The system will calculate a phantom stress value from the hypothetical “before” and “after” 
osition wafers, which should be repeatable on any system if the same parameters are used.  
ough the radius measurements may vary from system to system, the phantom “stress” value should 
consistent according to Toho specifications (2.5% on the same tool, 5% between systems).  The 
e two wafers should be used regularly for an SPC control of the FLX system stability and also for 

tem matching. 
 

ho Certified Results: 

X S/N  1099-4739 

F S/N  0508-0079 

*W afer  
THK 
µm 

Film 
THK Å  

Reference 
Radius 0  
FLX  
S/N  

Stress 
Mpa 
0 degrees 
STD DEV 

Reference 
Radius 90 
 

Stress 
Mpa 
90 degrees 
STD DEV 

rst Measurement using 
N416053, W aferAssembly, 
re, Silicon, 200 mm 

 
725um 
 

 
N/A 

 
-171.3 
 

 
N/A 

 
-186.0 
 

 
N/A 

ress-Time using 
N273031, W aferAssembly, 
ertified, 200 mm 

 
725um 

 
10000 

 
63.5 
 

 

341.5 
 

 
67.5 
 

 

319.0 
 

 
te: * W afer Thickness measured in FLX2320 

W afer Notch position in relation to the Scan direction. 
 

ho has maintained that the systems of the same model throughout the product line will 
tch to w ithin 5%, for the one particular system to within 2.5%.  

             Toho Technology Corporation      Date: 12 May 2008 
Clean system Division 

Manufacturing and Inspection 
 Equipment System Group   

                        
Signature                  
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8.8 Centered Laser Travel Verification
1. Go to the “Utilities” Menu from the main screen.

2. Select “Laser Intensity/ Move Laser”

3. Select the 670 laser.

4. Place a six inch wafer ring on the stage 
with no wafer.

5. Open the door.

6. Defeat the trap-door interlock.

Below the trap door is defeated with a metal scale between the frame and the plunger.
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7. With a six inch locating ring, set the “desired distance” to 50 (mm). 

8. Then click the “Move To” button.

9. Positive (no sign) “50”(mm) should send the laser to the right 50mm, which will 
place it on the edge of the 100mm ring.

10. Next, set the “desired” distance to “-50”.

Press the “Move To” button.

This will set the laser at the center again.

11. Press the “Move To” button again.

This will send the laser to the Left edge.

12. Set the laser to the center again. Then 
nudge the laser to the Left, with the left 
arrows on the Utility screen.

13. The Laser should hit the top of the left ball 
bearing. This will verify front to back align-
ment. 
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8.9 SYSTEM CONFIGURATION INFORMATION
The Configuration option on the Main menu displays additional system information such 
as Model Type, Serial number, Max Scan Length, RAM drive, and Motor Speed. 

Note that you cannot change any of the information displayed in this window.

To display the Configuration dialog box:

1. Choose Config from the View menu.

The Configuration dialog box displays:   

2. When you have finished reading the information, choose OK to return to the Main 
menu. 
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9 THEORY OF OPERATION

This chapter describes the theory of operation of the FLX-2320-S, and the equations used 
to calculate the diffusion, expansion, and elastic coefficients.

The FLX-2320-S measures the changes in the radius of curvature of a substrate caused by 
deposition of a stressed thin film. The stress in the thin film is calculated from the radius 
of curvature of the substrate using the following equation:

σ Eh2

1 v–( )6Rt
-------------------------=

where
E

1 v–( )
----------------  is the biaxial elastic modulus of the substrate (1.805E11 Pa for 100 silicon 

wafers)

h is the substrate thickness (m)

t is the film thickness (m)

R is the substrate radius of curvature (m)

σ is the average film stress (Pa)

The following picture is a schematic drawing of substrate deformed to radius R by the 
deposition of a film. In this case, the film is under compression deforming the substrate. 

x

Film

Substrate
t

h
R

θ
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To illustrate the stress calculation, suppose that a 100 mm silicon wafer, 525 µm thick, is 
deformed to a radius of 30 m by the deposition of a surface film of thickness 7500Å. Since 
the biaxial elastic modulus of 100 silicon is 1.802 x 1011 Pa, the stress calculated according 
to Equation 1 is 

σ 1.805 1011× 525 10 6–×( )
2

×
6 30 7500 10 10–×××( )

---------------------------------------------------------------------- 3.69 108× Pa 369MPa= = =

The average radius R1 of the bare substrate is obtained by measuring θ as a function of x 

and performing a linear regression. 1
R1
------  equals half the slope obtained from the linear 

regression. After the film is deposited, the substrate deforms to a new radius R2. Since the 

stress is proportional to 1
R
--- , it follows that 

1
R
--- 1

R2
------ 1

R1
------–=

or 

R 1
1
R2
------ 1

R1
------– 

 
------------------------

R1R2( )
R1 R2–( )

-----------------------= =

The thin film stress is now determined by using the effective radius R in the equation 
described above. To calculate the stress, the substrate radius must be measured before and 
after film deposition.

Single wavelength machines can run into destructive interference from transparent films 
such as silicon nitride. The Dual Wavelength system solves this problem by choosing 
automatically between two lasers and using the stronger reflection for measurement.
126
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DIFFUSION COEFFICIENT CALCULATION
The diffusion coefficient is calculated by the least square fitting to the diffusion equation 
into a finite film:

σ σ0 ∆σ 1 8
π2
----- 

  1
2n 1–( )

-------------------- 
  2 1 2n–( )2

4L2
----------------------π2Dt

 
 
 

–exp
1

∞

∑––=

where
σ  is the stress at time t
σ0  is the initial stress
∆σ  is the total stress change after completion
n is a running index from 1 to infinity
L is the film thickness
D is the diffusion coefficient
t is the time

For details on using this option, see Section 6.3, “Displaying Graphs.”

ELASTIC AND EXPANSION COEFFICIENT CALCULATION
The stress change with temperature in the elastic range is governed by the following 
equation:

dσ
dT
------ E

1 v–
----------- 

 
f

αs αf–( )=

where
dσ
dT
------  is the derivative of stress versus temperature
E

1 v–
----------- 

 
f
 is the biaxial modulus of the film

αs  is the substrate thermal expansion coefficient
αf  is the film thermal expansion coefficient

The above equation has two unknowns—αf  and E
1 v–
----------- 

 
f
. To solve these, two temperature 

cycles are done with two different substrates and the software solves two equations. For 
details on using this option, see Section 7.3, “Elastic and Expansion Coefficient Calcu-
lation.” 
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Autoscan. A scan in which the start and end 
scan positions are defined as 10% in from the 
edge of the wafer.

Elastic Modulus. The biaxial elastic modulus 
of the substrate to be used in stress calculations.

First (No Film) Measurement. A single scan 
performed on a wafer before deposition and used 
as a reference for subsequent scans.

Hole Diameter. The diameter of the center 
region of the substrate to be skipped.

Intrinsic Stress. The stress of a film at the 
deposition temperature.

Process Program. A set of parameters 
specifying information, such as the wafer 
diameter for measurement, elastic modulus, and 
substrate thickness.

Ramp Value. The rate of change of temperature 
in degrees Celsius (°C) per minute during a 
heating or cooling cycle.

Recipe. A recipe contains data that the 
instrument uses to automatically take a 
temperature measurement. The information in a 
recipe determines the setting of a stress-
tempera ture  measurement ,  the  t a rge t  
temperature, and the number of ramping readings 
for each measurement.

Record Comparison. A comparison of the 
deflection curves of the first stress and single 
stress measurements. Record Comparison also 
allows you to do stress and stress uniformity 
calculations as well as view intensity curves. This 
feature is only available on measurements where 
scan data has been saved.

Scan. Action performed when the Toho FLX-
2320 optical system and measurement stage are 
used to inspect wafers.

Single Stress Measurement. A single scan, 
performed on a wafer after film deposition, used 
to measure the induced stress.

Stress-Temperature Measurement. A scan 
used to measure stress as a function of 
temperature on a wafer after deposition. The 
instrument uses temperature cycling to reveal 
stress changes. Temperature cycling causes 
stress changes due to thermal expansion, 
mismatch, volume changes, and plastic 
deformations.

Stress-Time Measurement. Scans used in 
measuring the stress over a specified period of 
time, on a wafer after deposition. This type of 
measurement reveals the kinetics, such as wafer 
absorption in oxides, densification, phase 
transformations, and stress relaxation, of a wafer.

Temperature Controller. Instrument that 
displays the temperature heating and cooling 
cycle. The controller is located on the front panel 
of the measurement unit.

Thermal Stress. The film stress change 
between the deposition temperature and the 
measurement temperature.

Wafer Diameter. The diameter of the wafer in 
millimeters (mm).
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APPENDIX A – SPECIFICATIONS

PERFORMANCE SPECIFICATIONS

Substrate Diameter 100-mm (4-in.), 125-mm (5-in.), 150-mm (6-in.), and 200-
mm (8-in.) wafers. 

Measurement Speed: 5 sec. for 150-mm wafer  
Range: 1 x 107 to 4 x 1010 dyne/cm2 (stress upper limit 
increases with shorter scan length) 
RMS Noise: 0.0001 m-1 (radius=10,000 meters) at room 
temperature 
Resolution: 0.00003 m-1 (33 kilometers) 
Minimum Scan Step: 0.02 mm 
Maximum Points Per Scan: 1250 
Minimum Radius: 2.0 m (for 80 mm scan length)

Temperature Range Standard: Room temperature to 500o C 
Optional: -65o C to 500o C. (Factory installed only)

Repeatability The main source of the repeatability error is the replacement 
accuracy of wafers. The typical TOHO Technology 1σ error 
in   1

R
---  is 1x107 dynes/cm2 for a 1-µm film on a 525-µm 

silicon substrate. Thicker films and thinner substrates result 
in smaller errors and thinner films and thicker substrates 
result in larger errors. The following table lists stress errors 
for different film and silicon substrate combinations.

 

Substrate 
Thickness

Film Thickness (Å)

100,000 10,000 1,000 100

375 µm 0.5x106 0.5 x 107 0.5 x 108 0.5 x 109

525 µm 1.0x106 1.0 x 107 1.0 x 108 1.0 x 109

625 µm 1.4x106 1.4 x 107 1.0 x 108 1.4 x 109

675 µm 1.7x106 1.7 x 107 1.7 x 108 1.7 x 109

OPERATING SPECIFICATIONS 

Light Source Two lasers: 4-mW solid state (GaAlAs) laser with wave-
length 670 nm and 4-mW solid state (GaAlAs) laser with 
wavelength 780 nm. 
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PHYSICAL DIMENSIONS 

FLX-2320-S Instrument 46 cm (18 in.) x 46 cm (18 in.) x 56 cm (22 in.) plus 
computer 

WEIGHT 

System 45.5 kg (100 lb)

Shipping Weight 190 kg (420 lb)

OPERATING ENVIRONMENT 

Temperature  18–22° C (64–72° F)

Air Quality Clean room Class 100 or better 

Gas Connections  
(Optional)

Inert gas flow rate: 2–10 CFH(3L/min=6.4CFH);  
Cooling gas (typically CDA or N2) flow rate: Up to 500 
CFH (236L/min=500CFH); pressure not to exceed 40 psi 
(.3 MPa= 43.5psi)

System Power 15 amp. at 230 V, 50/60 Hz

COMPUTER AND PERIPHERALS 

Computer Windows

Hard Disk 320 GB

Monitor Flat Panel

DVD-RW
Floppy Diskette Drive

DVD, CDR, etc..
3.5-in. high density (1.44 MB)

Printer Hewlett-Packard, recommended

Comm Port
USB Ports

Serial cable
USB mouse
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APPENDIX B – CONSTANTS AND CONVERSIONS

This appendix lists selected constants and conversions. 

1 MPa = 107 dynes/cm2

1 GPa = 1010 dynes/cm2

1 angstrom  (A) = 0.0000001 mm

1 nanometer (nm) = .000001 mm

1 micron (mm) = .001 mm

Silicon Biaxial Moduli1: 

(100) 1.805 x 1011 Pa

(111) 2.290 x 1011 Pa




